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Legal information 

Warning notice system 
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER 

indicates that death or severe personal injury will result if proper precautions are not taken. 

WARNING 

indicates that death or severe personal injury may result if proper precautions are not taken. 

CAUTION 

indicates that minor personal injury can result if proper precautions are not taken. 

NOTICE 

indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING 

Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Introduction  1 
 

 

These instructions contain all information required to commission and use the device. Read 
the instructions carefully prior to installation and commissioning. In order to use the device 
correctly, first review its principle of operation. 

The instructions are aimed at persons mechanically installing the device, connecting it 
electronically, configuring the parameters and commissioning it, as well as service and 
maintenance engineers. 

The contents of this manual shall not become part of or modify any prior or existing 
agreement, commitment or legal relationship. The sales contract contains all obligations on 
the part of Siemens as well as the complete and solely applicable warranty conditions. Any 
statements regarding device versions described in the manual do not create new warranties 
or modify the existing warranty. 

The content reflects the technical status at the time of publishing. Siemens reserves the right 
to make technical changes in the course of further development. 

1.1 History 

The following table shows major changes in the documentation compared to the previous 
edition.  

 

Edition Remarks SW version FW revision 

12/2013 • First edition • SIMATIC PDM driver 1.00.01-01 2.03.02-01 

05/2015 • Update of SIMATIC PDM ver. 8 

• Update of Modbus holding registers: 
Modbus address 2215 to 2218 added. 

• SIMATIC PDM driver 1.01.00-00 2.03.03-01 

02/2016 • EAC Ex declaration information added • SIMATIC PDM driver 1.01.00-00 2.03.03-01 
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1.2 Items supplied 

With M12 plug connection 
 

• SITRANS FC410 flowmeter 

• Sensor cable with M12 connector 

• SD card with production certificates 

• Quick Start guide 

• CD containing software, certificates 
and device manuals 

 

With sensor terminal housing 
 

• SITRANS FC410 flowmeter 

• Sensor cable 

• Packet of cable glands 

• SD card with production certificates 

• Quick Start guide 

• CD containing software, certificates 
and device manuals 

 

 

 

 Note 

Supplementary information 

Supplementary product and production specific certificates are included on the 
SensorFlash® SD card. 

 

 Note 

Scope of delivery may vary, depending on version and add-ons. Make sure the scope of 
delivery and the information on the nameplate correspond to your order and the delivery 
note. 

 

1.3 Checking the consignment 

1. Check the packaging and the delivered items for visible damage. 

2. Report any claims for damages immediately to the shipping company. 
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3. Retain damaged parts for clarification. 

4. Check the scope of delivery by comparing your order to the shipping documents for 
correctness and completeness.  

 

 
 

WARNING 

Using a damaged or incomplete device 

Danger of explosion in hazardous areas. 

• Do not use damaged or incomplete devices. 

 

1.4 Device identification 

Each part of the FC410 Coriolis flowmeter has three nameplate types showing the following 
information: 

● product identification 

● product specifications 

● certificates and approvals 

 

  Note 

Identification 

Identify your device by comparing your ordering data with the information on the product 
and specification nameplates. 

 

FC410 sensor identification nameplate  

 

① Product name  Sensor product name 

② Serial no. Flowmeter serial number  

③ Sen. RS Mechanical sensor version number 

④ Manufacturer  Manufacturer name and location 

⑤ Country Manufacturing country 

⑥ System order no. Device-specific system order number 

Image 1-1 FC410 identification nameplate example 
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Flowmeter serial number construction 

The flowmeter serial number is constructed as follows: 

PPPYMDDxxxxxx 

where 
PPP = Production factory (Siemens Flow Instruments: FDK) 
Y = Production year (for encryption, see below) 
M = Production month (for encryption, see below) 
DD = Production date (for encryption, see below) 
xxxxxx = Sequential number 

Encryption: 
 

Calendar year (Y) Code 

1950, 1970, 1990, 2010 A 

1951, 1971, 1991, 2011 B 

1952, 1972, 1992, 2012 C 

1953, 1973, 1993, 2013 D 

1954, 1974, 1994, 2014 E 

1955, 1975, 1995, 2015 F 

1956, 1976, 1996, 2016 H (G) 

1957, 1977, 1997, 2017 J 

1958, 1978, 1998, 2018 K 

1959, 1979, 1999, 2019 L 

1960, 1980, 2000, 2020 M 

1961, 1981, 2001, 2021 N 

1962, 1982, 2002, 2022 P 

1963, 1983, 2003, 2023 R 

1964, 1984, 2004, 2024 S 

1965, 1985, 2005, 2025 T 

1966, 1986, 2006, 2026 U 

1967, 1987, 2007, 2027 V 

1968, 1988, 2008, 2028 W 

1969, 1989, 2009, 2029 X 

Month (M) Code 

January 1 

February 2 

March 3 

April 4 

May 5 

June 6 

July 7 

August 8 

September 9 
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October O 

November N 

December D 

Date (DD) Code 

Day 1 to 31 01 to 31 (corresponding to the actual date) 

FC410 sensor specification nameplate  

 

 

① EX approvals Ex approval specifications for the sensor (ATEX example) 

②  Consult the operating instructions 

③ CE CE mark 

④ 0539 Notified Body ID (ATEX) 

⑤ Ex Ex mark 

⑥ MAWP Maximum allowable working pressures at 20 °C (68 °F) and 200 °C 
(392 °F) (max. temperature) 

⑦ Fluid group Fluid group statement required by PED 

⑧ Wetted material Tube/process connection materials 

⑨ Min. fluid temperature Minimum fluid temperature 

⑩ Size DN Nominal size 

⑪ Conn. Process connection type and size 

⑫ Year of Manufacture Manufacturing year 
More detailed manufacturing date information is given in the serial 
number found on the identification nameplate 

⑬ Cal. Factor Calibration factor 

⑭ Qm (min) 

Qm (nom) 

Minimum and nominal flows with water at 20 °C (68 °F) 

⑮ Enclosure IP Degree of protection 

⑯ Ambient Temp. Ambient temperature range 

⑰ Accuracy Accuracy for massflow and density 

Image 1-2 FC410 specification nameplate example  
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FC410 Mini Flow Link (MFL) identification nameplate 

 

 

① Product name Name of device 

② Power supply Power supply 

③ Communication Communication: Modbus Master/Slave RTU technology 

④ Address range Modbus device address range 

⑤ Manufacturer Manufacturer name and location 

⑥ Country Manufacturing country 

⑦ HW Hardware version 

⑧ FW Firmware version 

Image 1-3 FC410 Mini Flow Link identification nameplate 

 

 Note 

Approval identifications 

Approval certificates and notified body identifications are available for download at 
siemens.com 

 

FC410 sensor approval nameplate 

 

① QR code Product-specific QR code 

② C✓ C-tick logo 

③ 3A 3A logo 

④  WEEE (Page 83) 

Image 1-4 FC410 approval nameplate example 
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 Note 

Logos and warnings 

Logos and warnings are only shown on the product where applicable. The combination 
shown in the example above is relevant for a hygienic sensor. 

The Australian C-tick mark is mandatory on all products.  

 

FC410 EHEDG nameplate 

 

Image 1-5 EHEDG nameplate 

This nameplate appears on all Hygienic sensors 7ME462. 

Other label 

 

Image 1-6 How to install 

The QR code provides direct internet connection to 

● The product support portal, which includes access to the How to Install YouTube video. 
(This example provides that function.) 

● Product and production-specific documentation maintained in the production database. 
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1.5 Further Information 

Product information on the Internet  

The Operating Instructions are available on the documentation disk shipped with the device, 
and on the Internet on the Siemens homepage, where further information on the range of 
SITRANS F flowmeters may also be found: 

Product information on the internet (http://www.siemens.com/flow)  

Worldwide contact person  

If you need more information or have particular problems not covered sufficiently by these 
Operating Instructions, get in touch with your contact person. You can find contact 
information for your local contact person on the Internet: 

Local contact person (http://www.automation.siemens.com/partner)  

http://www.siemens.com/flow
http://www.automation.siemens.com/partner
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Safety notes  2 
 

This device left the factory in good working condition. In order to maintain this status and to 
ensure safe operation of the device, observe these instructions and all the specifications 
relevant to safety. 

Observe the information and symbols on the device. Do not remove any information or 
symbols from the device. Always keep the information and symbols in a completely legible 
state. 
 

Symbol Explanation 

 

Consult operating instructions 

2.1 Laws and directives 

Observe the test certification, provisions and laws applicable in your country during 
connection, assembly and operation. These include, for example:    

● National Electrical Code (NEC - NFPA 70) (USA) 

● Canadian Electrical Code (CEC) (Canada) 

Further provisions for hazardous area applications are for example:   

● IEC 60079-14 (international) 

● EN 60079-14 (EC) 

Conformity with European directives    

The CE marking on the device symbolizes the conformity with the following European 
directives: 
 

Electromagnetic compatibili-
ty EMC  
2004/108/EC 

Directive of the European Parliament and of the Council on the 
approximation of the laws of the Member States relating to 
electromagnetic compatibility and repealing Directive 
89/336/EEC. 

Low voltage directive LVD  
2006/95/EC 

Directive of the European Parliament and of the Council on the 
harmonisation of the laws of Member States relating to electri-
cal equipment designed for use within certain voltage limits. 
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Atmosphère explosible 
ATEX  
94/9/EC 

Directive of the European Parliament and the Council on the 
approximation of the laws of the Member States concerning 
equipment and protective systems intended for use in potential-
ly explosive atmospheres.  

Pressure equipment directi-
ve PED  
97/23/EC 

Directive of the European Parliament and of the Council on the 
approximation of the laws of the Member States concerning 
pressure equipment. 

The applicable directives can be found in the EC conformity declaration of the specific 
device. Further country or region-specific code conformity information is available on 
request.  

 

 
WARNING 

Improper device modifications    

Danger to personnel, system and environment can result from modifications to the device, 
particularly in hazardous areas. 

• Only carry out modifications that are described in the instructions for the device. Failure 
to observe this requirement cancels the manufacturer's warranty and the product 
approvals. 

 

 

 Note 

CE declaration 

The CE declaration certificate is available on the SensorFlash SD card delivered with the 
device.  

 

 

 Note 

EAC declaration 

The EAC declaration is available on the SensorFlash SD card delivered with the device.  

 

2.2 Installation in hazardous locations 

 

 
WARNING 

Equipment used in hazardous locations 

Equipment used in hazardous locations must be Ex-approved for the region of installation 
and marked accordingly. It is required that the special conditions for safe use provided in 
the manual and in the Ex certificate are followed! 
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Hazardous location approvals  

The device is approved for use in hazardous locations and has the approvals listed below. 
Special conditions for safe installation and operation specified by each approval authority are 
included in the relevant certificate. 

ATEX: 

FC410 flowmeter (can be installed in Zone 1 for gas and Zone 20/21 for dust): 
Certificate: SIRA 11ATEX1341X 

 II 1/2 G 
1D 
2D 

For gas: 
Ex d ia IIC T* Ga/Gb  
Ex d IIC T* Ga/Gb 
(Ga/Gb: Zone 0 in pipe and Zone 1 in environment) 

For dust: 
Ex ta IIIC T* °C Da  
Ex tb IIIC T* °C Db 
(Zone 20 ("ta") process and ambient temperature limited in comparison with Zone 21 ("tb") 

Ta = -40°C to +60°C 

* Temperature class (dependent on the process temperature and the ambient temperatur) 

IECEx: 

FC410 flowmeter (can be installed in Zone 1 for gas and Zone 20/21 for dust): 
Certificate: IECEx SIR 11.0149X 

For gas: 
Ex d ia IIC T* Ga/Gb  
Ex d IIC T* Ga/Gb 
(Ga/Gb: Zone 0 in pipe and Zone 1 in environment) 

For dust: 
Ex ta IIIC T* °C Da  
Ex tb IIIC T* °C Db 
(Zone 20 ("ta") process and ambient temperature limited in comparison with Zone 21 ("tb") 

(Ta = -40°C to +60°C) 

* Temperature class (dependent on the process temperature and the ambient temperature) 

EAC Ex 

FC410 flowmeter / -40°C ≤ Tamb ≤ ** °C 

1Ex d ia IIC T* Ga/Gb 

Ex ta IIIC T** °C Da  

Ex tb IIIC T** °C Db 
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FM: 

Sensor with Mini Flow Link (MFL) (FC410):  

Class I, II, III Division 1 
Groups A, B,C,  D, E, F, G 
Class I Zone1 and Zone 20/21 

 

 Note 

Control drawing 

See Control drawing: A5E31205486A 

 

Maximum temperature specifications for Ex use  

Device temperature classification with and without dust is related to the process temperature 
and ambient temperature as listed below. 

The maximum allowable process fluid temperatures with respect to temperature class for the 
device when used with potentially explosive gases in a maximum ambient temperature of 
+60°C are: 
 

Ta (°C) Maximum Process Temperature per Temperature Class (°C) 

T6 T5 T4 T3 

60 70 70 70 70 

55 85 100 100 100 

50 85 100 130 130 

45 85 100 135 160 

40 85 100 135 190 

35 85 100 135 200 

30 85 100 135 200 

If the equipment is placed in a "tb" environment (Zone 21), the maximum process 
temperatures shall be as follows: 
 

Ta (°C) Maximum Process Temperature per Temperature Class (°C) 

60 70 

55 100 

50 130 

45 160 

40 190 

35 200 

30 200 

Additionally, the maximum surface temperature of the overall device shall be: 

● If Tprocess ≤ 85°C, maximum surface temperature = 85°C. 

● If Tprocess > 85°C, maximum surface temperature = process temperature. 
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If the equipment is placed in a "ta" environment (Zone 20), the maximum process 
temperature shall be as follows: 
 

Ta (°C) Maximum Process Temperature per Temperature Class (°C) 

60 -40 

55 -10 

50 20 

45 50 

40 80 

35 110 

30 140 

Special conditions for safe use 

In general, it is required that: 

● The equipment shall not be opened when energized and when an explosive gas or dust 
atmosphere may be present.. 

● Appropriate cable connectors are used. 

● Sensor is connected to the potential equalization throughout the hazardous area. 

● EN/IEC 60079-14 is considered for installation in hazardous areas. 

Further information and instructions including approval-specific special conditions for safe 
use in Ex applications can be found in the certificates on the accompanying literature CD 
and at www.siemens.com/FC410 (www.siemens.com/FC410). 

 

 
WARNING 

Laying of cables 
Explosion hazard 

Cable for use in hazardous locations must satisfy the requirements for having a proof 
voltage of at least 500 V AC applied between the conductor/ground, conductor/shield and 
shield/ground. 

Connect the devices that are operated in hazardous areas as per the stipulations applicable 
in the country of operation. 

 

 
WARNING 

Field wiring installation 

Ensure that the national requirements of the country in which the devices are installed are 
met. 

 

 

http://www.siemens.com/FC410
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2.3 Certificates 

Certificates are posted on the online support portal 
 
and can also be found on the documentation disk shipped with the device. 

 

(http://www.siemens.com/processinstrumentation/certificates) 

Certification documents including calibration report are supplied with each sensor included 
on the SensorFlash. Material, pressure test, and factory conformance certificates are 
optional at ordering. 

http://www.siemens.com/processinstrumentation/certificates
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Description  3 
 

 

Measurement of liquids and gases 

SITRANS F C Coriolis mass flowmeters are designed for measurement of a variety of liquids 
and gases. The flowmeters are multi-parameter devices offering accurate measurement of 
massflow, volumeflow, density, temperature and, depending on product variants, fraction, 
including industry-specific fractions. 

Main applications  

The main applications of the Coriolis flowmeter can be found in all industries, such as: 

● Chemical & Pharma: detergents, bulk chemicals, acids, alkalis, pharmaceuticals, blood 
products, vaccines, insulin production 

● Food & Beverage: dairy products, beer, wine, soft drinks, °Brix/°Plato, fruit juices and 
pulps, bottling, CO2 dosing, CIP/SIP-liquids, mixture recipe control 

● Automotive: fuel injection nozzle & pump testing, filling of AC units, engine consumption, 
paint robots 

● Oil & Gas: filling of gas bottles, furnace control, test separators, bore-hole plasticizer 
dosing, water-cut metering 

● Water & Waste Water: dosing of chemicals for water treatment 

 

 Note 

Use in a domestic environment 

This is a Class A Group 1 equipment intended for use in industrial areas.  

In a domestic environment this device may cause radio interference. 
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3.1 Design 

The SITRANS FC410 flowmeter uses the Coriolis principle to measure flow. The device is a 
one channel flowmeter with Modbus RTU RS 485 output. 

 

Image 3-1 Flowmeter - M12 connection 

 

Image 3-2 Flowmeter – terminated cable 

Flowmeter design  

All primary process measurement of massflow, volumeflow, density and process 
temperature are made in the MFL/sensor front end. 

The sensor comprises two parallel bent tubes welded directly to the process connections at 
each end via a manifold. 

The sensors are available in AISI 316L stainless steel and Hastelloy C22. The enclosure is 
made of AISI 304 stainless steel which has a pressure rating of 20 bar (290 psi) for DN 15 to 
DN 50 and 17 bar (247 psi) for DN 80. The burst pressure for all sizes is in excess of 160 
bar. 

The sensor enclosure can be equipped with a pressure guard or flushed with dry inert gas at 
the threaded ports for non-hazardous applications only. 

 

 Note 

Ex certification requires that the threaded ports always remain closed.  

 

The Mini Flow Link is available in an aluminum enclosure with an ingress protection grade of 
IP67/NEMA 4X. It has a 4-wire M12 cable or terminated cable connection for communication 
and power supply. 
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Flowmeter overview  

 

① Mini Flow Link (MFL) 

② Lid-lock 

③ Cable feed-through (M12 socket or gland) 

④ Plug and threaded port for example for pressure guard 

⑤ Sensor enclosure 

⑥ Process connections 

Image 3-3 Overview of FC410 flowmeter 

3.2 System integration 

The FC410 flowmeter functions as a Modbus RTU slave with standard Modbus commands 
implemented. Setup parameters, process values, diagnostics, and status information are 
mapped as Modbus registers.  

The device can be connected point-to-point or in a multidrop network in non-hazardous or 
hazardous locations. It can be connected to different hosts for example a PLC system or a 
PC used as service tool or configuration tool.  

 

 Note 

Multidrop installations in hazardous locations 

Multidrop installations in hazardous locations require flameproof conduit seals for each 
device, see illustrations in System configurations (Page 43) 

 

3.3 Modbus RTU technology 

Modbus RTU is an open, serial protocol based on master/slave architecture. The protocol 
interconnects field equipment such as sensors, actuators, and controllers and is widely used 
in both process and manufacturing automation. The fieldbus environment is the base level 
group of digital networks in the hierarchy of plant networks.  
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Features  

The SITRANS F Modbus RTU communication complies with the Modbus Serial Line 
Protocol. Among other things this implies a master / slave protocol at level 2 of the OSI 
model. A node (the master) issues explicit commands to one of the slave nodes and 
processes responses. Slave nodes will not transmit data without a request from the master 
node, and do not communicate with other slaves. 

Modbus is a mono master system, which means that only one master at a time can be 
connected. 

Unicast communication mode  

In unicast mode (master/slave mode) the master sends a request to a specific slave device 
and waits a specified time for a response.  

 

Image 3-4 Unicast Mode 

Modbus Frame  

The Modbus frame is shown below and is valid for both requests and responses. 

Table 3- 1 Modbus Frame 

SLAVE ADDRESS FUNCTION MODE DATA CRC 

1 Byte 1 Byte 0 to 252 Bytes 2 Bytes 

References  

For further information, please refer to the following specification and guidelines available at 
the Modbus Organization (http://www.modbus.org/) website 

1. Serial Line Specification & Implementation guide 

2. Application Protocol Specification 

 

http://www.modbus.org/
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3.4 Features 

● The SITRANS FC410 can be used as Modbus slave in stand-alone or parallel operation 
on Modbus or third party automation systems 

● Compact sensor design 

● NAMUR conforming sensor built-in lengths (on request) 

● High immunity against process noise 

● Fast response to step changes in flow 

● High update rate (100 Hz) on all process values 

● Measurement of: 

– Massflow 

– Volumeflow 

– Density 

– Process media temperature 

● Independent low flow cut-off settings for massflow and volumeflow 

● Automatic zero-point adjustment (initiated by host system) 

● Process noise damping using digital signal processing (DSP). 

● One totalizer for summation of massflow. The totalizer is reset on loss of power. 

● Empty pipe monitoring 

● Simulation of process values: 

– Massflow 

– Volumeflow 

– Density 

– Process media temperature 

● Troubleshooting and sensor checking 

● Use in hazardous locations according to specification 

3.5 Theory of operation 

The Coriolis principle of measurement  

The flow measurement is based on the Coriolis law of motion. Particles moving in a rotating / 
oscillating system will resist imposed oscillations in a manner consistent with their mass and 
velocity (momentum). Oscillation produced by a Coriolis flowmeter where the process media 
is accelerated around bends results in phase distortions of the measuring tubes. 

The SITRANS F C sensors are energized by an electromagnetic (voice coil) driver circuit 
which oscillates the pipes at their resonant frequency. Two pickups are placed symmetrically 
on either side of the driver to provide position signals for digital processing. 
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When the media flows through the sensor, Coriolis force will act on the measuring tubes and 
cause deflection which can be measured as a phase shift between Pickup 1 and Pickup 2. 
The phase shift is proportional to the mass flowrate. 

 

The frequency (or period) of the vibration is a direct function of the process media density. 

The frequency and amplitude of the driver is regulated to ensure a stable output from the 2 
pickups. The temperature of the sensor tubes is measured to provide accurate 
compensation for changes in the material stiffness. As a result the process media 
temperature is also accurately measured. 

The flow proportional phase signal from the pickups, the temperature measurement and the 
driver frequency enable calculation and reporting of mass, density, volume, and temperature. 

Digital signal processing (DSP)  

The analog to digital conversion takes place in an ultra low noise sigma delta converter with 
high signal resolution. With fast digital signal processing massflow and density values are 
calculated using a patented DFT technology (Discrete Fourier Transformation). The 
combination of this patented DFT technology and the fast DSP enables short response time 
(< 10 ms) to changes in the measured values.  

The built-in noise filter is configurable and can be used for improving the performance of the 
flowmeter, in case the installation and application conditions are not ideal. Typical process 
noise such as gas bubbles (two-phase-flow) can be reduced through the filter functions. 
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Installing/Mounting  4 
 

 

SITRANS F flowmeters with minimum IP67/NEMA 4X enclosure rating are suitable for indoor 
and outdoor installations. 

● Make sure that specifications for rated process pressure (PS) and media temperature 
(TS) plus ambient temperature that are indicated on the device nameplate / label will not 
be exceeded.  

 

 
 

WARNING 

Installation in hazardous location 

Special requirements apply to the location and installation of the device. See Installation 
in hazardous locations (Page 16). 

 

4.1 Flowmeter installation 

4.1.1 Installation safety precautions 

 

 
WARNING 

High pressure hazard 

In applications with working pressures/media that can be dangerous to people, 
surroundings, equipment or others in case of pipe fracture, we recommend that special 
precautions such as special placement, shielding or installation of a pressure guard or a 
safety valve are taken when the flowmeter is mounted.  

 

 

 
WARNING 

Exceeded maximum permissible operating pressure 

Danger of injury or poisoning. 

The maximum permissible operating pressure depends on the device version. The device 
can be damaged if the operating pressure is exceeded. Hot, toxic and corrosive process 
media could be released. 

• Make sure that the device is suitable for the maximum permissible operating pressure of 
your system. Refer to the information on the nameplate and/or in "Rated operating 
conditions (Page 94)". 
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CAUTION 

Hot surfaces resulting from hot process media 

Danger of burns resulting from surface temperatures above 70 °C (155 °F).  

• Take appropriate protective measures, for example contact protection. 

• Make sure that protective measures do not cause the maximum permissible ambient 
temperature to be exceeded. Refer to the information in Chapter "Rated operating 
conditions (Page 94)". 

 

 

 
CAUTION 

External stresses and loads 

Damage to device by severe external stresses and loads (e.g. thermal expansion or pipe 
tension). Process media can be released. 

• Prevent severe external stresses and loads from acting on the device. 

 

 

 
WARNING 

Wetted parts unsuitable for the process media 

Danger of injury or damage to device.  

Hot, toxic and corrosive media could be released if the process medium is unsuitable for 
the wetted parts.  

• Ensure that the material of the device parts wetted by the process medium is suitable for 
the medium. Refer to the information in "Technical data" (Page 99). 

 

 

 Note 

Material compatibility 

Siemens can provide you with support concerning selection of sensor components wetted by 
process media. However, you are responsible for the selection of components. Siemens 
accepts no liability for faults or failures resulting from incompatible materials. 

 

4.1.2 Determining a location 

 

 
CAUTION 

Electromagnetic fields 

Do not install the flowmeter in the vicinity of strong electromagnetic fields, for example near 
motors, variable frequency drives, transformers etc.  
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Upstream / downstream  

● No pipe run requirements, that is straight inlet/outlet sections are not necessary. 

● Avoid long drop lines downstream from the sensor to prevent process media separation 
causing air / vapour bubbles in the tube (min. back pressure: 0.2 Bar). 

● Avoid installing the flowmeter immediately upstream of a free discharge in a drop line. 

Location in the system  

The optimum location in the system depends on the application:  

● Liquid applications 
Gas or vapor bubbles in the fluid may result in erroneous measurements, particularly in 
the density measurement. 

– Do not install the flowmeter at the highest point in the system, where bubbles will be 
trapped. 

– Install the flowmeter in low pipeline sections, at the bottom of a U-section in the 
pipeline. 
  

 

Image 4-1 Liquid applications, wrong location with trapped air/gas 

● Gas applications 
Vapor condensation or oil traces in the gas may result in erroneous measurements. 

– Do not install the flowmeter at the lowest point of the system. 

– Install a filter. 
  

 

Image 4-2 Gas applications, wrong location with trapped oil 

4.1.3 Orientation of the device 

Flow direction  

The calibrated flow direction is indicated by the arrow on the sensor. Flow in this direction 
will be indicated as positive by default. The sensitivity and the accuracy of the sensor do not 
change with reverse flow. 
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The indicated flow direction (positive/negative) is configurable. 
 

 
CAUTION 

Accurate measurement 

The sensor must always be completely filled with process media in order to measure 
accurately. 

 

Orienting the sensor  

The sensor operates in any orientation. The optimal orientation depends on the process fluid 
and the process conditions. Siemens recommends orienting the sensor in one of the 
following ways: 

1. Vertical installation with an upwards flow (self-draining) 
 

 

Image 4-3 Vertical orientation, upwards flow 

2. Horizontal installation, tubes down (recommended for liquid applications) 
 

 

Image 4-4 Horizontal orientation, tubes down 
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3. Horizontal installation, tubes up (recommended for gas applications) 
 

 

Image 4-5 Horizontal orientation; tubes up 

 

  Note 

Hygienic applications 

In 3A and EHEDG certified hygienic applications the flowmeter must be installed vertically 
as shown in 1 above. 

 

Installation in a drop line   

Installation in a drop line is only recommended if a pipeline reduction or orifice with a smaller 
cross-section can be installed to create back-pressure and prevent the sensor from being 
partially drained while measuring. 

 

① Back pressure orifice 

② On / off valve 

Image 4-6 Installation in drop line 
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4.1.4 Mounting the flowmeter 

 

 
NOTICE 

Incorrect mounting 

The device can be damaged, destroyed, or its functionality impaired through improper 
mounting. 

• Before installing ensure there is no visible damage to the device. 

• Make sure that process connectors are clean, and suitable gaskets and glands are 
used. 

• Mount the device using suitable tools. Refer to the information in Chapter "Technical 
data (Page 91)", for example installation torques requirements. 

 

 
 

 
WARNING 

Unsuitable connecting parts 

Danger of injury or poisoning.  

In case of improper mounting hot, toxic and corrosive process media could be released at 
the connections. 

• Ensure that connecting parts (such as flange gaskets and bolts) are suitable for 
connection and process media. 

 

● Install the flowmeter in well-supported pipelines in order to support the weight of the 
device.  

● Center the connecting pipelines axially in order to assure a stress-free installation. The 
flowmeter must not be used to bring the rest of the pipework into line; make sure the 
pipework is correctly aligned before inserting the flowmeter. 

● Install two supports or hangers symmetrically and stress-free on the pipeline in close 
proximity to the process connections. 

 

 Note 

Handling 

Never lift the flowmeter using the housing, that is, always lift the sensor body. 
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Avoid vibrations  

● Make sure that no valves or pumps upstream of the flowmeter cavitates or sends 
vibration into the sensor. 

● Decouple vibrating pipeline from the flowmeter using flexible tube or couplings 

 

Image 4-7 Non-flexible pipes not recommended in vibrating environment 

 

Image 4-8 Flexible pipes recommended in vibrating environment 

Avoid cross talk  

If operating more than one flowmeter in one or multiple interconnected pipelines there is a 
risk of cross talk. 

Prevent cross talk in one of the following ways:  

● Mount sensors on separate frames 

● Decouple the pipeline using flexible tube or couplings 

 

Image 4-9 High risk of cross talk when using non-flexible pipes 

 

Image 4-10 Low risk of cross talk when using flexible pipes 
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4.1.5 Hydrostatic testing 

The flowmeter is pressure-tested before delivery to 1.5 times the rated working pressure of 
the sensor. 

● In the case of process connections pressure-rated less than 100 bar, the connection is 
the limiting component. 

● In the cases of stainless steel sensors with process connections pressure-rated above 
100 bar, the sensor is the limiting component. 

In all cases the maximum allowed hydrostatic test pressure (MATP) of the flowmeter is 1.5 
times the marked MAWP (PS) at 20 °C.  

 

 
WARNING 

Risk of equipment damage 

Never pressure test a completed flow system with piping and other components at 
pressures higher than 1.5 times the marked MAWP (PS) at 20 °C of the lowest rated 
component in the system.  

 

4.1.6 Mounting a pressure guard 

The sensor enclosure is supplied with two G½" (parallel thread) purge ports. These ports can 
for example be used for a pressure guard, which can be connected to an automatic shut off 
valve to stop the flow in case of sensor pipe fracture.  

 

 Note 

Non-hazardous locations only 

A pressure guard can be applied only in non-hazardous locations. 

 

 Note 

Avoid opening purge ports 

Opening either of the purge ports will void any Ex rating for the sensor.  

 

The AISI 304 / EN 1.4301 exterior enclosure is rated to approximately 20 bar static pressure 
to contain spilt process media in the event of a tube break. However it is not intended to 
contain high pressure or corrosive fluids and precautions must be taken in applications 
where vibrating tube failure is probable and may cause damage.  

Pressure guard selection 

Siemens does not supply the components of the pressure guard solution because the 
arrangement and components are closely related to individual safety and protection 
practices in each place.  
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The selection of pressure guard solution is the responsibility of the user, however Siemens 
recommends the following forms of pressure guard: 

● A pressure switch screwed directly or piped into one of the purge ports and connected to 
an automatic shut-off valve will disable pressurized supply to the meter. 

● A relief valve or bursting disc screwed directly or piped to one of the purge ports to carry 
any spilt fluid to drain after opening. 

The pressure switch and relief valve set point should be 2-3 bar gauge. The pressure switch 
should be rated to withstand the full process pressure and temperature for a short time 
without rupture. 

 

 
CAUTION 

Drain flow 

Ensure the drain flow is safely contained away from personnel and other plant or 
equipment. 

 

Mounting of pressure guard 
 

 
CAUTION 

Moisture, liquids or particles getting into the sensor enclosure 

All sensors are filled with argon to avoid condensation. Ingress of moisture, liquids or 
particles into the sensor may influence the measurement and in worst case inhibit the 
measuring function. 

• Avoid moisture, liquids or particles getting into the sensor enclosure 

 

Install a pressure guard as follows: 

1. Place the sensor in a dry, clean place and leave it to acclimatize until it reaches ambient 
temperature, preferred 20°C (68°F) with low humidity (at least below 50% RH). 

2. Orient the sensor with the purge ports uppermost to minimize loss of the argon gas filling. 

3. Carefully remove the plug and mount the pressure guard.  
Use replacement soft metal sealing rings for proper sealing. 

 

 
 

CAUTION 

Lack of proper sealing 

Soft metal sealing rings only maintain a hermetic seal within the enclosure with single 
use. 

• Ensure that soft metal sealing rings are not reused. 
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4. Make sure that the pressure guard does NOT touch any of the parts inside the sensor. 
Maximum of 20 mm (0.79") insertion can be accommodated. 

5. Check that the pressure guard has been correctly mounted and thoroughly tightened 
(torque: 80 Nm). 

 

 
 

WARNING 

Operation in proximity with pressure guards 

Prevent personal injuries by assuring that operation in close proximity with pressure 
guards cannot take place.  
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Connecting  5 
 

 

This chapter describes how the device is connected and integrated into a Modbus network in 
a point-to-point or multidrop configuration. 

5.1 Wiring in hazardous locations 

Hazardous area applications  

Special requirements apply to the location and interconnection of flowmeter and flameproof 
conduit seals. Two conduit seals per device must be installed; one at the device in the 
hazardous location and one in the non-hazardous location. 

 

 
WARNING 

MFL housing 

Before opening the MFL housing check that:  

• No explosion hazard exists 

• All connection leads are potential free 

 

5.2 Cable requirements 

Cable specifications  

● Only use cables with at least the same degree of protection as the sensor to install the 
sensor. It is recommended to use cables supplied by Siemens A/S, Flow Instruments. 

● Siemens supplied cables can be ordered with M12 plug on both ends or without plug. 

● To guarantee the IP67 degree of protection, ensure that both ends of the cables are given 
equivalent protection from ingress of moisture. 

● For further information on Siemens-supplied cables, see Technical Data (Page 101). 
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See also specifications of cable lengths in Wiring FC410 to the Modbus system (Page 48). 
 

 
WARNING 

Cable requirements 

Cables must be suitable for the temperature (at least 70 °C) and be flammability-rated to at 
least V-2. 

 

 

 
WARNING 

Unprotected cable ends 

Danger of explosion through unprotected cable ends in hazardous areas. 

• Protect unused cable ends in accordance with IEC/EN 60079-14. 

 

5.3 Safety notes for connecting 

 

 
WARNING 

Skills 

Only qualified personnel may carry out work on the electrical connections. 

 

Use in hazardous locations 

Before accessing the sensor terminal compartment and application terminal compartment 
check that: 

● No explosion hazard exists 

● FC410 may not be opened if energized 

● A safe access permission certificate has been issued by plant operations management 

● All connection leads are potential free 

 

 
 

WARNING 

Commissioning 

Only commission the device after the device has been properly connected and closed.  
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5.4 Connecting the FC410 

 

 Note 

End Of Line (EOL) termination 

The FC410 EOL termination DIP switch is default set to EOL active. To change termination 
setting see Setting the EOL termination DIP switches (Page 42). 

 

5.4.1 M12 version (for non-Ex areas) 

The device is provided with a preformed cable terminated with M12 style stainless steel 
weather-proof plugs. 

The cable screen is physically and electrically terminated within the body of the plug. 

Take care when handling the cable and passing it through cable ducting that the plug is not 
subjected to excessive tension (pulling) as the internal connections may be disengaged. 

 

 Note 

Never pull the cable by the plug - only by the cable itself. 

 

1. Connect the device using the supplied 4-wire cable with M12 connectors. 

 

  Note 

Grounding 

The sensor cable screen is electrically connected to the grounding terminal (PE), only 
when the M12 plug is correctly tightened. 

 
 

Terminal number Description Wire color (Siemens cable) 

1 24 VDC Orange 

2 0 VDC Yellow 

3 B White 

4 A Blue 
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5.4.2 Cable termination version 

A: Prepare the cable by stripping it at both ends. 

 

Image 5-1 Cable end 

B: Connect wires within the sensor terminal compartment 

1. Remove the lock screw and remove the lid. 

2. Undo the flexible strap. 

3. Disconnect the sensor connection (white plug) from the electronic. 

4. Loosen the mounting screw using a TX10 Torx driver and remove the electronic from the 
housing. 

5. Remove the cap and the ferrule from the cable gland and slide onto the cable. 

6. Push the cable through the open gland and anchor the cable shield and the wires with the 
clamp bar. 

7. Remove the terminal block from the electronic. 

8. Connect the wires to the terminals according to the list below. 

 

Terminal number Description Wire color (Siemens cable) 

1 24 VDC Orange 

2 0 VDC Yellow 

3 B White 

4 A Blue 
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Image 5-2 Sensor terminal compartment 

 

9. Reinstall the electronic including the mounting screw. 

10.Connect the sensor connection and the sensor cable. 

11.Restore the flexible strap around all wires. 

 

12.Assemble and tighten the cable gland. 

13.Remove the O-ring from lid. 

14.Reinstate the lid and screw in until the mechanical stop. Wind back the lid by one turn. 

15.Mount the O-ring by pulling it over the lid and tighten the lid until you feel friction from the 
O-ring on both sides. Wind the lid by one quarter of a turn to seal on the O-ring. 

16.Reinstate and tighten the lid lock screw. 
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5.4.3 Setting the EOL termination DIP switches 

It is important to terminate the Modbus RS 485 line correctly at the start and end of the bus 
segment since impedance mismatch results in reflections on the line which can cause faulty 
communication transmission. 
 
If the device is at the end of the bus segment, it is recommended to terminate the device as 
shown in System configurations (Page 43). The table below shows the relation between the 
DIP switch settings and the permissible communication interface set-ups. Default 
configuration is EOL active.  

Location of DIP switch 

The DIP switch is located in the electronic as shown below. 

 

Image 5-3 DIP switch location (all set to ON) 

DIP switch settings for communication set-up 
 

DIP switch Communi-
cation set-up  

Switch 1 Switch 2 Switch 3 Switch 4 

EOL active On On On On 

EOL not active On On Off Off 

 

 

 
NOTICE 

Avoid DIP switch settings not mentioned in the table! 

DIP switch settings not mentioned in the table above are not allowed and may reduce 
communication interface reliability. 

 

See also 

System integration (Page 23) 
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5.5 Integrating the FC410 with Modbus system 

This chapter provides information on how to integrate the flowmeter in a point-to-point or 
multidrop Modbus RTU network in non-hazardous or hazardous locations. Many details of 
network design are beyond the scope of these operating instructions. The points below 
provide an overview of the  major design criteria. For further details contact Siemens. 

If the device is integrated in a hazardous location, two flameproof conduit seals per device 
must be installed; one at the device in the hazardous location and one in the non-hazardous 
location, see System configurations (Page 43). 

5.5.1 System configurations 

Non-hazardous locations 

The following figures show examples of installations in point-to-point and multidrop 
configurations in non-hazardous locations. 

 

Image 5-4 Point-to-point configuration in non-hazardous location with Ex d certified cable gland for 
use in Zone classified areas only 
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Image 5-5 Multidrop configuration (branch) in non-hazardous location 
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Image 5-6 Multidrop configuration (Daisy chain) in non-hazardous location 

 

 
NOTICE 

M12 plugged systems 

Daisy chain multidrop configuration is NOT possible with M12 plugged systems. 
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Hazardous locations 

The following figures show examples of installations in point-to-point and multidrop 
configurations in hazardous locations. 

 

 

Image 5-7 Point-to-point configuration in hazardous location 
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Image 5-8 Multidrop configuration in hazardous location 
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NOTICE 

Flameproof conduit seals 

Two flameproof conduit seals are required for each device in hazardous area installations, 
one on DSL and one where cables leave hazardous area.. 

 

 
NOTICE 

Equipment approved for hazardous locations 

Ensure that the equipment is approved for installation in hazardous locations. 

 

5.5.2 Wiring FC410 to the Modbus system 

FC410 is slave in a 2-wire Modbus RTU RS 485 bus system. Terminal A on the FC410 must 
be connected to terminal A on the master/host system. Terminal B on the FC410 must be 
connected to terminal B on the master/host system This corresponds to a half-duplex 
communication where the slave will only reply to a request from the master. 

● This example shows an EMC shielded enclosure for multidrop installation where the 
connection includes signal and power. Cable shield must be grounded at host system, in 
connection box, and at flowmeter to comply with EMC requirements. Keep the cable 
shield to the ground as short as possible. 

 

Siemens can supply suitable cable (gray) for non-hazardous area installations in required 
lengths to be ordered with the system. The cables can be ordered with M12 plugs on both 
ends or without plug. 
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Topology 

FC410 supports a two-wire electrical interface in accordance with EIA/TIA-485 standard. 

An RS485 Modbus configuration without repeater has one trunk cable, along which devices 
are connected, directly (daisy chaining) or by short branch cables. 

 

 Note 

Multidrop examples in this document show a trunk cable with short branch cables. 

 

Maximum cable lengths 

The end to end length of the trunk cable must be limited. The maximum length depends on 
the baud rate, the cable (gauge, capacitance or characteristic Impedance), the number and 
types of loads on the daisy chain, and the network configuration. 

 

 Note 

Maximum branch cable length 

Branch cables must be short, never more than 20 m. 

 

 

Image 5-9 Maximum cable lengths in multidrop configuration 



Connecting  

5.5 Integrating the FC410 with Modbus system 

 FC410 with Modbus 

50 Operating Instructions, 02/2016, A5E33120874-AC 



 

FC410 with Modbus 

Operating Instructions, 02/2016, A5E33120874-AC 51 

Commissioning  6 
6.1 General requirements 

Before commissioning it must be checked that: 

● The device has been installed and connected in accordance with the guidelines provided 
in Installing/Mounting (Page 27) and Connecting (Page 37). 

● Device installed in hazardous area meets the requirements described in Installation in 
hazardous locations (Page 16). 

6.2 Warnings 

 

 
WARNING 

Improper handling 

The sensor connected to this device can be operated with high pressure and corrosive 
media. Therefore improper handling of the device can lead to serious injuries and/or 
considerable material damage. 

 

 

 
WARNING 

Commissioning and operation with pending error 

If an error message appears, correct operation in the process is no longer guaranteed. 

• Check the gravity of the error. 

• Correct the error. 

• If the error still exists: 

– Take the device out of operation. 

– Prevent renewed commissioning. 

 

6.3 Operating via SIMATIC PDM 

SIMATIC PDM is a software package used to commission and maintain process devices. 
Further information can be found at: www.siemens.com/simatic-pdm 
(www.siemens.com/simatic-pdm). 

 

http://www.siemens.com/simatic-pdm
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6.4 Functions in SIMATIC PDM 

SIMATIC PDM monitors the process values, alarms and status signals of the device. It 
allows you to display, compare, adjust, verify, and simulate process device data; also to set 
schedules for calibration and maintenance. 

Parameters are identified by name and organized into function groups. See Modbus 
addressing model (Page 117) for a table and Changing parameter settings using SIMATIC 
PDM (Page 64) for more details. 

See Parameters accessed via drop-down menus (Page 64) for parameters that do not 
appear in the menu structure in SIMATIC PDM. 

 

 Note 

Supported SIMATIC PDM versions 

The EDD supporting this product is compatible with SIMATIC PDM v. 6.0 + SP5 + HF5 or 
from v. 8.2 + SP1. 

 

6.5 Commissioning steps 

In the following it is described how to commission the device with SIMATIC PDM.  

The steps are divided into the following sections: 

1. Initial setup (Page 52) 

2. Adding device to the communication network (Page 54) 

3. Configuring a new device (Page 55). 

4. Wizard - Quick start with PDM (Page 56) 

5. Wizard - Zero point adjustment 

6.6 Initial setup 

To ensure that SIMATIC PDM connects properly, please complete the two processes 
outlined below: 

1. Deactivating buffers 

2. Updating the Electronic Device Description (EDD) 
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Deactivating buffers for RS 485 com port 

This deactivation is required to align SIMATIC PDM with the Modbus modem for Windows® 
operating systems. 

 

 Note 

Support for Windows operating systems can be found here: 
support.automation.siemens.com (http://support.automation.siemens.com) 

 

1. Click Start → Control Panel to begin configuration. 

2. Click on Hardware and Sound and then on Device Manager. 

3. Open Ports folder and double-click the COM Port used by the system to open the 
Communications Port Properties window. 

4. Select the Port Settings tab and click the Advanced button. 

5. If the Use FIFO buffers check box is deselected, click to select. 

6. Set Receiver Buffer and Transmitter Buffer to Low (1). 

 

7. Click OK to close out. Close all screens and then reboot. 

Updating the Electronic Device Description (EDD) 

You can locate the EDD in the SIMATIC PDM Device Library under Devices → Modbus → 
Sensors → Flow → Coriolis → Siemens AG → SITRANS FC410. Check the product page of 
our website at: www.siemens.com/FC410, under Downloads, to make sure you have the 
latest version of SIMATIC PDM, the most recent Service Pack (SP) and the most recent hot 
fix (HF). 

Installing a new EDD: 

1. Download the EDD from the product page of our website at: www.siemens.com/FC410 
and save the files to your computer. 

2. Extract the zipped file to an easily accessed location. 

3. Launch the SIMATIC PDM Device Integration Manager, browse to the unzipped EDD file 
and select it. 

 

http://support.automation.siemens.com/
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6.7 Adding device to communication network 

Before setting the parameters, it is necessary to configure the FC410 project in PDM.  

1. Add the device to SIMATIC Modbus network:  

– Select File → New 
Type in a project name, for example FC410 commissioning. 

– Go to View and select Process Device Network view. 

– Right-click on the typed in Project name and select Insert New Object → Networks. 

– Right-click on Networks and Insert New Object → Communication Network. 

– Click on Assign Device Type and select Modbus Network. 
Click OK two times. Your PC is now added to the Modbus Network. 

– Right-click Modbus Network and select Insert New Object → Object. 

– Click on Assign Device Type, and select Devices → Modbus → Sensors → Flow → 
Coriolis → SIEMENS AG → SITRANS FC410 
Click OK two times. 

 

Image 6-1 Assigning Modbus device to network 

2. Set up the communication parameters for SIMATIC Modbus network:  

– Select Networks → My computer, right-click on COM Port Interface and select Object 
Properties. 

– Select the Communication tab and configure the communication parameters. FC410 
default settings are: 

 - Transmission rate: 19200 baud  
 - Parity: even 
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Image 6-2 Modbus net object properties 

– Click OK. 

3. Set up the COM interface: 

– Select Modbus Networks. 

– Right-click on the object name SITRANS FC410 and select Object Properties. 

– Select the Communication tab and configure the Modbus address. 

 

Image 6-3 Set the Modbus address 

– Click OK. 

6.8 Configuring a new device 

 

 Note 

Clicking on Cancel during an upload from device to SIMATIC PDM will result in some 
parameters NOT being updated. 
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1. Check that you have the most recent EDD, and if necessary update it, see Updating the 
Electronic Device Description (EDD) in Initial setup (Page 52). 

2. Launch SIMATIC Manager. 

3. Right-click on SITRANS FC410 and select Open Object to open SIMATIC PDM. 

4. Click on Device and select Upload to PG/PC Wizard... to configure the device. 

See also 

Wizard - Quick Start via PDM (Page 56) 

6.9 Wizard - Quick Start via PDM 

The graphic Quick Start Wizard provides an easy 5-step procedure that configures the 
device for a simple application. 

Please consult the SIMATIC PDM operating instructions or online help for details on using 
SIMATIC PDM. 

Access level control 

The parameters are protected against changes by access level control. To gain access, 
select Access Management from the device menu, select User and enter the PIN code.  

The default user PIN code is 2457. 

Quick start 
 

 Note 

- The Quick Start wizard settings are inter-related and changes apply only after you click on 
Apply and Transfer at the end of step 5 to save settings offline and transfer them to the 
device. 

- Do not use the Quick Start Wizard to modify individual parameters. 

- Click on Back to return and revise settings or Cancel to exit the Quick Start. 

 

Launch SIMATIC PDM, open the menu Device → Wizard - Quick Start..., and follow steps 1 
to 5. 
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Step 1 - Identification 
 

 Note 

The layout of the dialog boxes shown may vary according to the resolution setting for your 
computer monitor. The recommended resolution is 1280 x 960. 

 

1. Click on Read Data from Device to upload Quick Start parameter settings from the device 
to the PC/PG and ensure PDM is synchronized with the device. 

2. Click on Next to accept the default values. (Descriptor, Message, and Date fields can be 
left blank.) 

 

Image 6-4 Quick start step 1 
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Step 2 - Sensor orientation 

Step 2 shows an overview of the various recommended installation orientations depending 
on the application. 

 

Image 6-5 Quick start step 2 



 Commissioning 

 6.9 Wizard - Quick Start via PDM 

FC410 with Modbus 

Operating Instructions, 02/2016, A5E33120874-AC 59 

Step 3 - Sensor connection 

An FC410 can be ordered with M12 connection or with terminated cable (for example 
conduit connections). 

 

Image 6-6 Quick start step 3 
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Step 4 - Measurement conditions 

Configure the measurement conditions for the selected process variables. Change Flow 
Direction if necessary. Units are local in PDM. 

 

Image 6-7 Quick start step 4 
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Reduce the sensitivity of the flow measurement signal by clicking on the Pulsating Flow 
button and selecting the appropriate filter. 

 

Image 6-8 Filter setting selection 



Commissioning  

6.10 Wizard - Zero Point adjustment 

 FC410 with Modbus 

62 Operating Instructions, 02/2016, A5E33120874-AC 

Step 5 - Summary 

Check parameter settings, and click on Back to return and revise values, Apply to save 
settings offline, or Apply and Transfer to save settings offline and transfer them to the device. 

 

Image 6-9 Quick start step 5 

The message Quick Start was successful will appear. Click on OK. 

See also 

Configuring a new device (Page 55) 

6.10 Wizard - Zero Point adjustment 

Open the menu Device → Wizard → Zero Point Adjustment. 
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Select Auto. Click on Next. 

 

It is recommended to use the default settings. Change the Zero Point Adjustments Settings, 
if necessary. 

Click on Auto Zero Point Adjustment. 
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6.11 Changing parameter settings using SIMATIC PDM 

 

 Note 

For a complete list of parameters, see the Modbus addressing model (Page 117). 

Clicking on Cancel during an upload from device to SIMATIC PDM will result in some 
parameters NOT being updated. 

 

Many parameters are accessed via the online menus in PDM, see Parameters accessed via 
drop-down menus (Page 64) for the others. 

1. Launch SIMATIC PDM, connect to the appropriate device and upload data. 

2. Adjust parameter values in the parameter value field then click on Enter. The status fields 
read Changed. 

3. Open the Device menu, click on Download to device, then use File → Save to save 
settings offline. The status fields are cleared. 

 

6.12 Parameters accessed via drop-down menus 

Click on Device or View to open the associated drop-down menus. 
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Drop-down menus 

Table 6- 1 Device menus 

Device menus Description 

Communication Path  Shows the communication interface (Modbus RTU) 

Download to Device Downloads all writable parameters to the device 

Upload to PC/PG Uploads all parameters from the device to the parameter 
table 

Update Diagnostic Status Reads current diagnostic status from the device and 
updates the diagnostic status icon 

Communication Sets communication parameters, for example baud rate 

Wizard - Quick Start Guide for a quick commissioning 

Wizard - Zero Point Adjustment Guide for zero point adjustment (automatic and manual) 

Totalizer (online dialog) Controlling massflow totalizer 

Maintenance (online dialog) Setup of maintenance functions 

Simulation (online dialog) Simulation of process values 

Access Management  Possibility to upgrade access level from User to Expert 
and to change PIN code for Expert level 

 

Table 6- 2 View menus 

View menus Description 

Process Variables (online dialog) Shows all process values 

Device Diagnostic (online dialog) Shows all diagnostics information (alarms and diagnos-
tics parameters) 

Toolbar (online dialog) Shows/hides the toolbar 

Status Bar Shows/hides the status bar 

Update Updates the content of the active window 

6.13 Zero point adjustment 

The flowmeter system is optimized through a zero point adjustment.  

Performing a zero point adjustment  
 

 Note 

Preconditions 

Before a zero point adjustment is initiated, the pipe must be flushed, filled and at an absolute 
flowrate of zero preferably also at operating pressure and temperature. 
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1. Flush out the flowmeter until a homogenous flow is established and the tubes completely 
filled. 

 

Image 6-10 Best practice zero point adjustment with a by-pass line and two shut-off devices 

2. Establish zero flow for example by closing the shut off-valves. 

3. Wait 1 to 2 minutes, for the system to settle, and then perform zero adjustment as 
described in the following steps. 

4. Select Device → Wizard → Zero Point Adjustment... from the main menu of SIMATIC PDM 
to perform an automatic zero point adjustment. 

 

5. Click Next and then Auto Zero Point Adjust. 
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6. During the process a progress bar is visible. 

7. At the end of the zero adjustment, the outcome is displayed as an offset and a standard 
deviation. 

 

  Note 

If you get an error message after the zero point adjustment, refer to Alarms and system 
messages (Page 79). 

 

The system is now ready for normal operation. 

6.14 Process variables 

1. To compare outputs in real time select View → Process Variables to see all process 
values, totalizers and loop current. 

2. Verify that the process values show the expected values. 

 

Image 6-11 Process variables 

Trend view 

Open the menu View → Process Variables and click on one of the Trend View buttons to 
monitor the trend of one or all process values available at each tab. 



Commissioning  

6.14 Process variables 

 FC410 with Modbus 

68 Operating Instructions, 02/2016, A5E33120874-AC 



 

FC410 with Modbus 

Operating Instructions, 02/2016, A5E33120874-AC 69 

Functions  7 
 

 

In the following the main functionalities of the device are described in detail. 

For overview of all functions and parameters, refer to Modbus holding registers (Page 117).  

7.1 Process values 

According to standard practice with serial communication the Modbus RTU signal reports 
primary process values and error status strictly with SI units1) – kilogram, meter, second and 
degree Celsius.  

1) 1 kg/s of water flow equals 0.001 m³/s of volume flow, and 3600 kg/h.   

The process values are updated every 10 ms (100 Hz update rate) synchronous with the 
DSP update cycle.  

Process value parameters 

The process values are:  

● Massflow (MassflowValue) [kg/s] 

● Volumeflow (VolumeflowValue) [m3/s] 

● Density (Density) [kg/m3] 

● Process media temperature (FlowMediaTemp) [°C] 

7.2 Zero point adjustment 

In the following the automatic zero point adjustment function is described. For further details, 
see Zero point adjustment. 

 

 Note 

Preconditions 

Before a zero point adjustment is initiated, the pipe must be flushed, filled and at an absolute 
flowrate of zero preferably also at operating pressure and temperature. Refer to appendix 
Zero point adjustment (Page 141) for more details. 

 

 Note 

Change of parameters during zero point adjustment 

Do not change any other parameter during the zero point adjustment procedure. 
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Automatic zero point adjustment  

The device measures and calculates the correct zero point automatically. 

The automatic zero point adjustment of the flowmeter is set by the following parameters: 

● Duration (Modbus address 2135) 

● Start Zero Point Adjustment (Modbus address 2180) 

When zero adjust is initiated by selecting Start Zero Point Adjustment, the massflow values 
are acquired and totalized for the configured period (Duration). The default zero point 
adjustment period (30 s.) is normally sufficient for a stable zero point measurement.  

 

 Note 

Extremely low flow quantity 

If the flow quantity is extremely small, extremely precise measurement is necessary. In this 
case, a long zero point adjustment period can be selected for improved zero point 
adjustment. 

 

Zero point calculation 

During zero point adjustment, an average value is automatically calculated using the 
following formula: 
 

Zero Point Offset Value 

Average of N flow values 

 

xi is an instantaneous flow value sampled in 
the time domain 

N = Number of samples during zero point 
adjustment 

The offset value must be within the determined Zero Point Offset Limit (Modbus address 
2140). 

 

 Note 

Exceeded zero point offset limit 

If the offset value is greater than the configured limit, proceed as follows: 

• Check that the tube is completely filled and that the flowrate is absolute zero. 

• Check the validity of the configured zero point offset limit. 

• Repeat the zero point adjustment. 
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Zero point standard deviation 

After completion of the procedure, the standard deviation is calculated in accordance with 
the following formula: 
 

Zero Point Standard Deviation 

Standard deviation of N values 

 

The standard deviation contains important feedback on the homogeneity of the fluid, for 
example on the presence of bubbles or particles. 

The standard deviation must be within the determined Standard Deviation Limit (Modbus 
address 2138).  

 

 Note 

Exceeded standard deviation limit 

If the standard deviation is greater than the configured limit, proceed as follows: 

• Check that the tube is completely filled and that the flow rate is absolute zero. 

• Check that the installation is vibration-free. 

• Check the validity of the configured standard deviation limit in parameter 2.6.4 Standard 
Deviation Limit. 

• Repeat the zero point adjustment. 

 

Successful automatic zero point adjustment 

If the new zero point offset value is valid, it is automatically stored as the new zero point for 
the sensor. It remains stored in the case of a power failure. 

Manual zero point adjustment 

In case an automatic zero point adjustment cannot be performed, it is possible to do a 
manual zero point adjustment by entering the zero point offset value. 

1. Select Modbus address 2132 Zero Point Adjustment and set the value to 1 = Manual 
Zero Point Adjustment. 

2. Select Modbus address 2133 Manual Zero Point Offset and enter the desired offset 
value. 

7.3 Low flow cut-off 

In certain applications, as for instance batching applications, no flow signals under a certain 
flow level are desired. In these applications, the flow signal can be forced to zero, when the 
flow is lower than a predefined flow value (Low Flow Cut-Off).  
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SITRANS FC410 provides two parameters for setting the low flow cut-off: 

● Low Mass Flow Cut-Off (Modbus address 2125)  

● Low Volume Flow Cut-Off (Modbus address 2170) 

7.4 Empty tube monitoring 

The empty tube monitoring function uses the process density for detecting an empty tube. 
Use of this function is recommended for all standard applications.  

 

 Note 

Gas applications 

Deactivate the empty tube monitoring function. 

 

Empty tube monitoring parameters 

Two parameters for setting the empty tube monitoring function are available: 

● Empty Tube Detection (Modbus address 2129) 

● Empty Tube Limit (Modbus address 2127) 

The empty tube monitoring is activated via the Empty Tube Detection parameter. When the 
empty tube monitoring function is on, the massflow / volumeflow value is forced to zero if the 
tube is empty. 

The tube is defined as empty, if the measured density value is lower than the value defined 
via the Empty Tube Limit parameter. 

 

 Note 

Process media density 

Risk of unintentionally forcing flow values to zero, if the difference between the empty tube 
limit density value and the density of the process media is not sufficient. 

• Ensure sufficient difference between the empty tube limit density value and the process 
media density 
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7.5 Process noise damping 

Noise damping function  

The dynamic sensitivity of the flow measurement signal to rapid changes in process flows 
can be reduced by use of the process noise damping function. The function is typically used 
in environment with: 

● Strongly pulsating flow 

● Changing pump speeds 

● Large pressure variations 

Process noise damping settings 

Reduce interfering process noise by increasing the setting of the parameter Process Noise 
Damping (Modbus address 2130). 

● Centrifugal pump (1: low) 

● Triplex pump (2) 

● Duplex pump (3) 

● Simplex pump (4) 

● Cam pump (5: high) 

The default value is Duplex pump. The damping affects all functions and outputs of the 
sensor. 

 

Image 7-1 Centrifugal pump (1: low) 

 

Image 7-2 Triplex pump (2) 



Functions  

7.6 Totalizer 

 FC410 with Modbus 

74 Operating Instructions, 02/2016, A5E33120874-AC 

 

Image 7-3 Duplex pump (3; default setting) 

 

Image 7-4 Simplex pump (4) 

 

Image 7-5 Cam pump (5: high) 

 

 Note 

Increased reaction time 

The reaction time of the sensor increases when the process noise is damped. 
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7.6 Totalizer 

Totalizer function 

The device has one totalizer function that can be used to totalize the massflow process 
value. 

The totalizer may be paused, resumed or reset: 

● Pause (Modbus address 2613): the totalizer holds the last value before the failure 
occurred 

● Resume (Modbus address 2614): the totalizer continues counting the actual measured 
value 

● Reset (Modbus address 2612): the totalizer continues counting based on the last input 
value (for example massflow) before the failure occurred. 

 

 Note 

The totalizer is reset on power failure. 

 

7.7 Access management 

All parameters may be viewed, but some are protected against changes by access level 
control.  

The Access Management menu makes it possible to gain access to PIN code protected 
parameters and to change PIN codes. 

 

Image 7-6 Access Management menu 
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The access levels are: 

● Read Only 
Allows no configuration. The user is only able to view the parameter values. No PIN code 
is required. 

● User 
Allows configuration and service of all parameters except calibration parameters. Default 
PIN code is 2457. 

 

 Note 

Auto Log Off function 

The access level will be set to Read Only mode if the device is powered off 

 

7.8 Simulation 

Simulation is used for testing purposes, typically for checking that the readings of the control 
system are correct. 

Process value simulation 

The following process values can be simulated: 

● Massflow (Modbus address 2764) 

● Density (Modbus address 2766) 

● Process Media Temperature (Modbus address 2768) 

● Frame Temperature (Modbus address 2770) 

● Volumeflow (Modbus address 2772) 

The simulation can be activated through SIMATIC PDM in the menu Device → Simulation → 
Process Variables. 
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7.9 Changing Modbus communication settings 

Changing communication parameters, for example Baud Rate, Modbus Parity Framing or 
Bus Address effects the Modbus communication as follows: 

● The new settings have effect only after a reset, either by restarting the device or writing 
the value 1 to Modbus address 600 Restart communication. 

● The new settings will not have effect until the Modbus driver has responded to any 
ongoing Modbus request. 

 

 
 NOTICE 

Setting addresses in a multidrop network 

It is recommended NOT to use the default address in a multi-drop network. When 
setting device addresses, make sure that each device has a unique address. 
Replication of addresses may cause abnormal behavior of the entire serial bus and 
make the master unable to communicate with all slaves on the bus.  

 

7.10 Float transmission 

The Float Byte Order function ensures that the master and slave use the same sequence of 
the bytes when transmitting float values. This enables the user to configure the FC410 using 
the configuration tool, SIMATIC PDM, and operate the device with all types of PLCs without 
reprogramming the PLC. The transmission order is configured by setting the parameter Byte 
Order in the submenu Device → Communication. 

 
 

 Note 

The command Restart Communication must be executed to activate the new byte order 
setting. 
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This table shows the different options for setting the transmission method: 
 

Selection Sequence 

1st 2nd 3rd 4th 

1 - 0 - 3 - 2 Byte 1 

(MMMMMMMM) 

Byte 0 

(MMMMMMMM) 

Byte 3  

(SEEEEEEE) 

Byte 2  

(EMMMMMMM) 

0 - 1 - 2 - 3 Byte 0 

(MMMMMMMM) 

Byte 1 
(MMMMMMMM) 

Byte 2  

(EMMMMMMM) 

Byte 3  

(SEEEEEEE) 

2 - 3 - 0 - 1 Byte 2 

(EMMMMMMM) 

Byte 3  

(SEEEEEEE) 

Byte 0 

(MMMMMMMM) 

Byte 1 

(MMMMMMMM) 

3 - 2 - 1 - 0 * Byte 3 

(SEEEEEEE) 

Byte 2  

(EMMMMMMM) 

Byte 1 

(MMMMMMMM) 

Byte 0 

(MMMMMMMM) 

 * = Factory setting 

S = Sign 

E = Exponent 

M = Mantissa 
 

 

 
NOTICE 

Change of float byte order 

If the float byte order is changed by use of PDM to anything other than default, all float 
values shown in PDM are wrong. 
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Alarms and system messages  8 
8.1 Alarm messages 

In the following tables the bits for alarm group 1 and alarm group 2 can be found along with 
possible causes and directions for corrective action. 

Alarm group 1 (Modbus address 3012) 
 

Bit Diagnostic Action 

4 
5 

Sensor supply volt. out of range Contact Siemens customer support 

6 
7 
8 
9 

Temperature measurement fault Contact Siemens customer support 

10 
11 
12 
13 

Flow values not valid Can be due to problems with measured fluid or hardware malfunction. If the 
failure continues then contact Siemens customer support 

14 Invalid calibration data Contact Siemens customer support for recalibration 

15 Invalid compensation data Contact Siemens customer support 

17 
18 

Malfunction in Pickup Amplitude Contact Siemens customer support 

23 
24 
25 

Malfunction in sensor driver Contact Siemens customer support 

26 Unstable driver oscillation Contact Siemens customer support 

27 Massflow out of specification Reduce the flow. If the failure continues then contact Siemens customer 
support 

28 Volumeflow out of specification Reduce the flow. If the failure continues then contact Siemens customer 
support 

29 Density out of specification Contact Siemens customer support 

30 Fluid temp. below limit Increase the fluid temperature. If the failure continues then contact Siemens 
customer support 

31 Fluid temp. above limit Reduce the fluid temperature. If the failure continues then contact Siemens 
customer support 



Alarms and system messages  

8.1 Alarm messages 

 FC410 with Modbus 

80 Operating Instructions, 02/2016, A5E33120874-AC 

Alarm group 2 (Modbus address 3014) 
 

Bit Diagnostic Action 

0 Frame temp. below limit Increase fluid temperature and check that ambient temperature is within 
specified limits. If the failure continues then contact Siemens customer sup-
port 

1 Frame temp. above limit Reduce fluid temperature and check that ambient temperature is within 
specified limits. If the failure continues then contact Siemens customer sup-
port 

2 Standard Deviation above limit 
 
(shown for only 2 seconds) 

Measurement continues with values from last successful zero point adjust-
ment. Improve conditions for automatic zero point adjustment and repeat 
adjustment.  

3 Zero Point Offset above limit 
 
(shown for only 2 seconds) 

Measurement continues with values from last successful zero point adjust-
ment. Improve conditions for automatic zero point adjustment and repeat 
adjustment.  

4 Zero point adjustment failed 
 
(shown for only 2 seconds) 

Measurement continues with values from last successful zero point adjust-
ment. Improve conditions for automatic zero point adjustment and repeat 
adjustment.  

5 Empty Tube Limit exceeded Make sure that the sensor is filled with liquid and that the liquid density is 
within the specified Empty Tube Limit 

6 The sensor is partially filled Make sure that the sensor is filled with liquid  

7 Parameter storage malfunction Turn off the power, wait 5 seconds and turn on the power again. If the failure 
continues then contact Siemens customer support 

8 
9 
10 
11 
12 
13 

Internal error in sensor Contact Siemens customer support 

14 Unstable measurement condition Check if air is present in the liquid and that the flowmeter is operated within 
its specifications 

15 Auto filtering Check that the flowmeter is operated within its specifications. Check other 
alarms to rule out HW malfunction 

23 The sensor is stabilizing Turn off the power, wait 5 seconds and turn on the power again. If the failure 
continues then contact Siemens customer support. 
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Service and maintenance  9 
9.1 Maintenance 

The device is maintenance-free. However, a periodic inspection according to pertinent 
directives and regulations must be carried out.   

An inspection can include check of: 

● Ambient conditions 

● Seal integrity of the process connections, cable entries, and cover screws 

● Reliability of power supply, lightning protection, and grounds 

 

 
 NOTICE 

Repair and service must be carried out by Siemens authorized personnel only. 

 

  Note 

Siemens defines flow sensors as non-repairable products.    

 

9.2 Maintenance information parameters 

The basic maintenance parameters are: 

● Operating Time Total (Since first power-up) 

● Operating Time Since Power Up (Since latest power-up) 

9.3 Service information 

Service information is information about the condition of the device used for diagnostics and 
service purposes.   

Service information parameters 

The basic service information parameters are: 

● Driver Current 

● Pickup 1 Amplitude 

● Pickup 2 Amplitude 

● Sensor Frequency 

● Frame Temperature 
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● Process Media Temperature 

● Zero Point Adjustment Auto/Manual 

● Zero Point Offset Value 

● Manual Zero Point 

● Zero Point Standard Deviation 

9.4 Recalibration 

Siemens A/S, Flow Instruments offers to recalibrate the sensor at our works in Denmark. 
The following calibration types are offered as standard according to configuration:  

● Standard calibration 

● Density calibration 

 

  Note 

SensorFlash 

For sensor recalibration the SensorFlash memory unit must always be returned with the 
sensor. 

 

9.5 Technical support 

If you have any technical questions about the device described in these Operating 
Instructions and do not find the right answers, you can contact Customer Support:  

● Via the Internet using the Support Request:  
 Support request (http://www.siemens.com/automation/support-request)  

● Via Phone: 

– Europe: +49 (0)911 895 7222 

– America: +1 423 262 5710 

– Asia-Pacific: +86 10 6475 7575 

Further information about our technical support is available on the Internet at  
 Local contact person (http://www.automation.siemens.com/partner)  

Service & Support on the Internet 

In addition to our documentation, we offer a comprehensive knowledge base online on the 
Internet at:  

Service and support (http://www.siemens.com/automation/service&support)  

http://www.siemens.com/automation/support-request
http://www.automation.siemens.com/partner
http://www.siemens.com/automation/service&support
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There you will find: 

● The latest product information, FAQs, downloads, tips and tricks. 

● Our newsletter, providing you with the latest information about your products. 

● Our bulletin board, where users and specialists share their knowledge worldwide. 

● You can find your local contact partner for Industry Automation and Drives Technologies 
in our partner database. 

● Information about field service, repairs, spare parts and lots more under Services. 

Additional Support  

 If you have additional questions about the device, please contact your local Siemens 
representative and offices at: 

Technical support (http://support.automation.siemens.com/WW/view/en/16604318) 

9.6 Transportation and storage 

To guarantee sufficient protection during transport and storage, observe the following: 

● Keep the original packaging for subsequent transportation. 

● Devices/replacement parts should be returned in their original packaging. 

● If the original packaging is no longer available, ensure that all shipments are properly 
packaged to provide sufficient protection during transport. Siemens cannot assume 
liability for any costs associated with transportation damages. 

 

 
 

CAUTION 

Insufficient protection during storage 

The packaging only provides limited protection against moisture and infiltration. 

• Provide additional packaging as necessary. 

 

Special conditions for storage and transportation of the device are listed in Technical data 
(Page 91).  

9.7 Device disposal 

 

 

Devices identified by this symbol may not be disposed of in the 
municipal waste disposal services under observance of the 
Directive 2002/96/EC on waste electronic and electrical 
equipment (WEEE).  

They can be returned to the supplier within the EC or to a local-
ly approved disposal service. Observe the specific regulations 
valid in your country. 

http://support.automation.siemens.com/WW/view/en/16604318
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9.8 Maintenance work 

 

 
CAUTION 

Hot surfaces 

Danger of burns during maintenance work on parts having surface temperatures exceeding 
70 °C (158 °F).  

• Take corresponding protective measures, for example by wearing protective gloves. 

• After carrying out maintenance, remount touch protection measures. 

 

 
WARNING 

Humid environment 

Danger of electric shock. 

• Avoid working on the device when it is energized. 

• If working on an energized device is necessary, ensure that the environment is dry. 

• Make sure when carrying out cleaning and maintenance work that no moisture 
penetrates the inside of the device. 

 

 
CAUTION 

Dangerous voltage at open device 

Danger of electric shock when the enclosure is opened or enclosure parts are removed. 

• Before you open the enclosure or remove enclosure parts, de-energize the device. 

• If maintenance measures in an energized state are necessary, observe the particular 
precautionary measures. Have maintenance work carried out by qualified personnel. 

 

 
WARNING 

Hot, toxic or corrosive process media 

Danger of injury during maintenance work. 

When working on the process connection, hot, toxic or corrosive process media could be 
released. 

• As long as the device is under pressure, do not loosen process connections and do not 
remove any parts that are pressurized. 

• Before opening or removing the device ensure that process media cannot be released. 
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 Troubleshooting/FAQs  10 
10.1 Diagnosing with PDM 

SIMATIC PDM is a suitable tool for diagnosing the device.  

You can use SIMATIC PDM to read all available parameters to a table for analyzing offline, 
view online/actual process values and online/actual diagnostic information.  

Requirements 

The following procedure must be completed before diagnosing: 

● Installation of PDM and PDM device driver 

● Connection of Modbus interface. 

Refer to Commissioning (Page 51). 

Diagnosing with PDM 

Online process values are available under menu View → Process Values. 

Online diagnostic information is available under menu View → Device Status.  

10.2 Troubleshooting 

Incorrect and unstable measurements, especially at low flows, are typically a result of an 
unstable zero point due to: 

● Incorrect installation 

● Bubbles in the liquid 

● Vibrations/Cross talk 

● Solid particles settling in the liquid 

In the following a 4-step guide to troubleshooting is provided: 
 

Step 1 Preliminary application inspection 

Step 2 Zero point adjustment 

Step 3 Measurement error calculation 

Step 4 Application improvement 

The guide will enable you to trace the reason for incorrect measurements and to improve the 
application. 
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Step 1: Inspecting the application 

Ensure that: 

1. The sensor is installed as described in Installing/mounting (Page 27). 

2. The sensor is located in a vibration-free position. Vibrations can disturb the sensor and 
therefore cause measurement error. 

Depending on application, you should furthermore ensure the following: 

● Liquid application 
Ensure that the sensor is filled with liquid and liquid only.  
Air or gas bubbles in the liquid cause instability and can result in measurement errors.  
Flush the pipe systems and the sensor for several minutes at maximum flowrate to 
remove any air bubbles which may be present. 

 

  Note 

The liquid must be homogeneous in order to measure with high accuracy. If the liquid 
contains solid particles of greater density than the liquid, then these solids can settle, 
especially at low flow rates, which will cause instability in the sensor and lead to 
measurement errors. 

For pastes or process fluids with suspended solids always orient the sensor vertically with 
flow in upward direction to maintain solids suspension. 

 

● Gas application 
Ensure that the gas pressure/temperature conditions contain sufficient superheat to 
prevent dewing or precipitation. If the gas contains vapor or droplets then these may 
precipitate, causing instability. 

Step 2: Performing a zero point adjustment 

The second step in the troubleshooting procedure is to zero point adjust the device. For 
further information on zero point adjustment, see Commissioning (Page 51). 

Step 3: Calculating the measurement error 

The result of the zero point adjustment will show you if the zero point was set under good 
and stable conditions.  

The lower the obtained value of the parameter Zero Point Standard Deviation, the lower is 
the achievable measuring error. For a well-installed flowmeter, the Zero Point Standard 
Deviation corresponds to the specified zero point stability for the sensor size, see 
Performance (Page 93). 

The parameter Zero Point Standard Deviation is located in the Maintenance & Diagnostics 
menu in the SIMATIC PDM. 
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Calculating the measurement error 

Given the Zero Point Standard Deviation, the error expected for different flow rates can be 
calculated, without performing time-consuming measurements. So using this formula, one 
can assess if the application can be used as–is, or whether to use more time improving the 
installation. 
 

E = Z x 100 % / Qm 

Where: 
 

E = measurement error in % of flowrate 

Z = zero point standard deviation value in kg/h 

Qm = current flowrate in (kg/h) 

Example 1: Low flow application 

● DN 15 sensor. The sensor's nominal flowrate is specified to 3700 kg/h 

● Zero point error (Zero Point Standard Deviation) value is specified as 0.2 kg/h 

● Flow: Min. 10 kg/h - Max. 100 kg/h 

After the zero point adjustment, the Zero Point Standard Deviation value 'Z' is read as 1 kg/h, 
that is 5 times greater than that specified for the sensor.  

The error for a flowrate of 10 kg/h is estimated as: 

● E = 1 kg/h x 100% / 10 kg/h = 10%. 

For a flowrate of 100 kg/h the error is estimated as: 

● E = 1 kg/h x 100% / 100 kg/h = 1% 

For this application it is necessary to investigate more closely what the cause of the relatively 
high Zero Point Standard Deviation value is, in order to establish what needs to be done to 
improve the measurement accuracy. 

Example 2: High flow application 

DN 15 sensor. The sensor flowrate is specified as max. 3700 kg/h 

● The zero point error/ Zero Point Standard Deviation value is specified as 0.2 kg/h 

● Flowrate: Min. 1000 kg/h - Max. 3000 kg/h 

After the zero point adjustment, the Zero Point Standard Deviation value 'Z' is read as 1 kg/h, 
that is 5 times greater than specified for the sensor ! 

The error at a flowrate of 1000 kg/h is estimated as: 

● E = 1 kg/h x 100% / 1000 kg/h = 0.1% 

At a flowrate of 3000 kg/h the error is estimated to be: 

● E = 1 kg/h x 100% / 3000 kg/h = 0.03% 

In all of the above examples, the linearity error of ±0.1% must be added to the calculated 
error. 
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As can be seen, in this case it is not so important that the standard deviation is 1 kg/h. The 
error due to the zero point is only 0.1% for a flowrate of 1000 kg/h, and even less for a higher 
flowrate. 

So for this installation with the given flowrate and zero point error (Zero Point Standard 
Deviation value), you should typically choose not to spend more time finding ways to 
improve the application. 

See also 

Maintenance & Diagnostics (Page 128) 

Step 4: Improving the application 

In the following it is described how to find the causes of a high Zero Point Standard Deviation 
and how to improve the installation. 

Setting Low Flow Cut-Off 

In order to see if the zero point becomes more stable when making changes / adjustments, 
the Low Mass Flow Cut-Off (MassFlowCutOff) must be set to 0.0%.  

When Low Flow Cut-Off has been set, it is possible to see the instability directly from the 
massflow in the online window (View → Process Variables) 

This information can be used to troubleshoot. For example, tightening the brackets which 
hold the sensor, or turning off the pump to check if vibrations from the pump are disturbing 
the sensor, etc. 

Incorrect installation of the sensor  

● Has the sensor been correctly installed, that is fastened to the floor / wall or frame with 
good mounting brackets as shown in the instructions? 

Especially for low flowrates, that is flowrates less than 10% of the maximum capacity of the 
flow meter, it is important that the sensor is correctly and stably installed. 

If the sensor is not correctly fixed in place, the zero point of the sensor will change, leading 
to measuring errors. 

Try to tighten up the sensor brackets to see whether the flow instability is reduced. 

Vibrations and cross talk  

Vibrations in the pipe system are normally generated by pumps. 

Typically, cross talk is generated by two sensors of identical size and positioned in close 
proximity in the same pipe, or installed on the same rail or frame. 

Vibrations / cross talk have a greater or lesser effect upon the zero point stability and 
therefore also the measurement accuracy. 

1. Check whether there are vibrations. 
Turn off the pump and check whether the zero point stability improves, that is if the 
flowrate fluctuation in kg/h is reduced. 
If the sensor is disturbed by vibration from the pump or by pressure pulsations, the 
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installation should be improved or the pump should be exchanged, for example to 
another type. 

2. Check for cross talk. 
Turn off the power to the other flow meter(s) and wait approximately 2 minutes, so the 
vibrating tubes in the sensor have stopped vibrating. Then check if the zero point stability 
has improved, that is that the fluctuation in kg/h has been reduced. If this is the case, the 
sensors disturb one another and the installation should be improved. 

Air in the liquid 

When air is present in the liquid, the zero point becomes unstable, which leads to a poor 
measurement accuracy. 

Checking for air: 

● Check the Driver Current (View → Device Diagnostics → Advanced Diagnostic) 

● Check if the Driver Current varies more than ±1 mA. If this is the case, it is usually due to 
the presence of air or gas bubbles in the liquid. 

● Increase the pressure in the sensor, creating a large back pressure upon the sensor by 
reducing the opening of the outlet valve or by increasing the pump pressure. Thereby the 
size of air bubbles inside the sensor will be minimized. If the Driver Current value 
increases and / or the stability of the Driver Current decreases, it is proof that the liquid 
contains air or gas bubbles. 

Typical causes of air in the liquid 

● The entry pipe and sensor have not been properly filled with liquid. 

● The pump cavitates, the rotary speed of the pump is too high in relation to the supply of 
liquid to the pump. 

● The flow rate in the pipe is too high, so components sitting in front of the flowmeter can 
cause cavitation. 

● If there is a filter installed before the flowmeter, it may be close to blocking, which also 
can cause cavitation. 

● Liquid flashes to vapor bubbles while passing through partially open valves or orifices. 

● The piping on the pump suction side, pump gaskets or the pump itself is not tight. Air gets 
sucked into the system due to a low pressure on the pump suction side. 

Solid particles in the liquid 

If the solid particles in a liquid have a density higher than that of the liquid, they can 
precipitate inside the sensor and cause instability which leads to a measurement error. 

If solid particles are present in the liquid, they must be homogeneously distributed and have 
similar density as the liquid. Otherwise they can cause relatively large measurement errors. 

It is important that the sensor is installed such that solid particles can easily run out of the 
sensor.  

1. Ensure that the sensor is installed vertically with an upwards flow. 

2. Check if solid particles are present in the liquid: 
Take a sample of the liquid, fill a glass and see if the solids precipitate. 
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 Technical data  11 
11.1 Function and system design 

Table 11- 1 Designated use  

Description Specification 

Measurement of process media • Fluid Group 1 (suitable for dangerous fluids) 

• Aggregate state: Paste/light slurry, liquid and 
gas 

 

Table 11- 2 Function and system design  

Description Specification 

Measuring principle Coriolis 

System architecture • Point-to-point (1 Modbus RTU master - 1 
FC410 slave) 

• Multidrop (1 Modbus RTU master - up to 32 
FC410 slaves per segment. Max 247 slaves) 

  

11.2 Process variables 

Table 11- 3 Process variables  

Description Specification 

Primary process vari-
ables 

• Massflow 

• Density 

• Fluid temperature 

Derived process vari-
able 

• Volumeflow 
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11.3 Modbus Communication Specification 

Table 11- 4 Modbus communication specification  

Description Specification 

Device type Slave 

Baud rates • 9600 

• 19 200 (Factory setting) 

• 38 400 

• 57 600 

• 76 800 

• 115 200 

Number of stations Max. 31 per segment without repeaters 

Device address range 1 to 247 

Protocol Modbus RTU 

Electrical interface RS 485, 2-wire 

Connector type M12 / Cable termination 

Supported function codes • 3: read holding registers 

• 16: write multiple registers 

• 8: diagnostics 

Broadcast No 1) 

Maximum cable length [m] 600 meters (@ 115 200 bits/sec) 

Standard Modbus over serial line v 1.0 2) 

Certification one 

Device Profile None 

1): Standard restriction. The standard requires a LED indicator for visual diagnosis. This 
device does not support a LED indicator. Instead comprehensive display information is 
available. This device does not react to any Broadcast commands. 

2): According to the Specification & Implementation guide v. 1.0 available at the Modbus 
Organization website 

 

 Note 

Storage location 

All Modbus settings of the device are stored in a non-volatile memory. 
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11.4 Performance 

Table 11- 5 Reference conditions  

Description Specification 

Process media Water 

Process media temperature  20 °C (68 °F) 

Ambient temperature 25 °C (77 °F) 

Process media pressure 2 bar (29 psi) 

Process media density 0.997 g/cm3 (62.2 lb/ft3) 

Reference device orientation Horizontal installation, tubes down, flow in direc-
tion of arrow on casing, see Installing/Mounting 
(Page 27). 

 

Table 11- 6 Massflow accuracy  

Description Specification 

Sensor size DN 15 DN 25 DN 50 DN 80 

Qmin - minimum flowrate [kg/h] (lb/min) 20 
(0.735) 

200 
(7.35) 

750 
(27.6) 

900 
(33.1) 

Qnom - nominal flowrate [kg/h] (lb/min) 3700 
(136) 

11 500 
(422.6) 

52 000 
(1 911) 

136 000 
(4 997) 

Qmax - maximum flowrate [kg/h] (lb/min)  6 400 

(235.2) 

17 700 

(650.4) 

70 700 

(2598) 

181 000 

(6651) 

Max. zero point stability [kg/h] ±0.2 ±2.0 ±7.5 ±18.0 

Measuring accuracy [%] ±0.10 

Repeatability error [%] ±0.05 

 

Table 11- 7 Density accuracy  

Description Specification 

Density accuracy, standard calibration [kg/m³] ±5 

Density accuracy, extended calibration [kg/m³] ±0.5 

Density repeatability [kg/m³] ±0.25 

Density, media pressure effect [(kg/m³)/Bar] ±0.5 

Density, media temperature effect [(kg/m³)/°C] ±0.1 

 

Table 11- 8 Media temperature accuracy  

Description Specification 

Media temperature accuracy [°C] ±1 

Media temperature repeatability [°C] ±0.25 
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Table 11- 9 Additional error by deviations from reference conditions 

Description  Specification 

Sensor size DN 15 DN 25 DN 50 DN 80 

Effect of process pressure 
[% of actual flowrate per bar] 

±0.015 ±0.015 ±0.015 ±0.015 

Effect of process pressure at nominal flowrate 
[(kg/h) per bar] 

0.56 1.73 7.8 20.4 

Effect of ambient temperature  
[% / K actual flowrate]  

Display/Frequency/Pulse output: 

< ±0.003  < ±0.003  < ±0.003  < ±0.003 

Effect of power supply fluctuations None None None None 

Effect of media temperature [(kg/h)/°C] ±0.0875 ±0.175 ±1.05 ±3.15 

11.5 Rated operating conditions 

Table 11- 10 Basic conditions  

Description Specification 

Ambient temperature (°C[°F]) 
(Humidity max. 90 %) 

Operation -40 to +60 [-40 to +140] 

Ambient temperature (°C[°F])  
(Humidity max. 90 %) 

Storage 
 

-40 to +70 [-40 to +158] 

Climate class DIN 60721-3-4 

Altitude Up to 2000 m (6560 ft) 

Relative humidity [%] 95 

Bump resistance On request 

Shock resistance On request 

Thermal shock On request 

Vibration resistance On request 

EMC performance EN/IEC 61326-1 (Industry) 

 

Table 11- 11 Cleaning and sterilizing conditions 

Description Specification 

Cleaning method • CIP 

• SIP 

Cleaning temperature On request 

Cleaning frequency On request 

Cleaning duration On request 
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Table 11- 12 Process media conditions 

Description Specification 

Process media temperature (Ts) (min to max) [°C (F)] -50 to +200 (-58 to 492) 

Process media density (min to max) [kg/m3 (lb/ft3] 1 to 5000 (0.06 to 312) 

Process media gauge max pressure [bar (psi)] 160 (2321) Hastelloy  

100 (1450) st. steel 

Pressure drop  See Pressure drop curves (Page 95)  

Pressure temperature ratings See Pressure - temperature ratings 
(Page 95)  

 

11.6 Pressure drop curves 

The pressure drop is dimension-dependent and influenced by process media viscosity and 
density. Sensors with undersized process connections experience higher pressure drop due 
to reduction in inlet/outlet dimensions. 

 

 Note 

Pressure drop information 

Pressure drop information is available on request. 

 

11.7 Pressure - temperature ratings 

Pressure - temperature ratings are determined by process connection material and 
applicable standards. The tables below detail the allowed maximum process pressure for 
sensor variants with stainless steel and Hastelloy measuring tubes. 

With two major exceptions, the pressure rating of the flow sensors is independent of the 
process medium temperature. Design rules for flange connections in both the EN1092-1 and 
ASME B16.5 standards dictate pressure derating with increasing temperature. The charts 
below show the effect of process medium temperature on the pressure ratings for the 
flanges within the product program. 
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Image 11-1 Metric flange ratings, EN 1092-1 (P: Process pressure; T: Process temperature) 

 

Image 11-2 ANSI flange ratings, ASME B16.5 (P: Process pressure; T: Process temperature) 

11.7.1 Stainless steel sensors 

Table 11- 13 EN1092-1 [bar] 

PN (bar) Temperature TS (°C) 

-50 0 50 100 150 200 

16 16.0 16.0 16.0 15.2 13.8 12.7 

40 40.0 40.0 40.0 37.9 34.5 31.8 

63 63.0 63.0 63.0 59.7 54.3 50.1 

100 100.0 100.0 100.0 94.8 86.2 79.5 

160 100.0 100.0 100.0 100.0 100.0 100.0 

 

Table 11- 14 ISO228-G and ASME B1.20.1 NPT [bar] 

PN (bar) Temperature TS (°C) 

-50 0 50 100 150 200 

100 100.0 100.0 100.0 100.0 100.0 100.0 
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Table 11- 15 ASME B16.5 [bar] 

Class / 
Group 

Temperature TS (°C) 

-50 0 50 100 150 200 

150 / 2.3 15.8 15.8 15.3 13.3 12.1 11.1 

300 / 2.3 41.3 41.3 39.8 34.8 31.4 29.0 

600 / 2.3 82.6 82.6 79.7 69.6 62.9 58.1 

900 / 2.3 100 100 100 100 94.2 87.5 

Table 11- 16 JIS [bar] 

PN (bar) Temperature TS (°C) 

-50 0 50 120 150 200 

10K 14 14 14 14 13.4 12.4 

20K 34 34 34 34 33.1 31.6 

40K 68 68 68 68 66.2 63.2 

63K 100 100 100 100 100 99 

Table 11- 17 DIN 11851 [bar] 

PN (bar) / DN Temperature TS (°C) 

-50 0 50 100 140 

25 / 50-100 25 25 25 25 25 

40 / 10-40 40 40 40 40 40 

Table 11- 18 DIN 32676 & ISO 2852 [bar] 

PN (bar) / DN Temperature TS (°C) 

-50 0 50 100 140 

10 / 85-219.1 10 10 10 10 10 

16 / 48.3-76.2 16 16 16 16 16 

25 / 6.35-42.4 25 25 25 25 25 

Table 11- 19 DIN 11864 & ISO 2853 [bar] 

PN (bar) / DN Temperature TS (°C) 

-50 0 50 100 140 

25 / 50-100 25 25 25 25 25 

40 / 10-40 40 40 40 40 40 

Table 11- 20 Swagelok SS-12-VCO-3 socket weld with SS-12-VCO-4 nut [bar] 

PN (bar) Temperature TS (°C) 

-50 0 50 100 150 200 

100 100.0 100.0 100.0 100.0 100.0 100.0 
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 Note 

Test pressure 

Maximum allowable test pressure (MATP) for the flowmeter and process connection is 1.5 
times the nominal pressure up to 150 bar (2176 psi). 

11.7.2 Hastelloy sensors 

Table 11- 21 EN1092-1 [bar] 

PN (bar) Temperature TS (°C) 

-50 0 50 100 150 200 

16 16.0 16.0 16.0 16.0 16.0 16.0 

40 40.0 40.0 40.0 40.0 40.0 40.0 

63 63.0 63.0 63.0 63.0 63.0 63.0 

100 100.0 100.0 100.0 100.0 100.0 100.0 

160 160.0 160.0 153.0 145.0 134.0 125.0 

 

Table 11- 22 ISO228-G and ASME B1.20.1 NPT [bar] 

PN (bar) Temperature TS (°C) 

-50 0 50 100 150 200 

100 100.0 100.0 100.0 100.0 100.0 100.0 

160 160.0 160.0 153.0 145.0 134.0 125.0 

 

Table 11- 23 ASME B16.5 [bar] 

Class Temperature TS (°C) 

-50 0 50 100 150 200 

150 20.0 20.. 19.5 17.7 15.8 13.8 

300 51.7 51.7 51.7 51.5 50.3 48.6 

600 103.4 103.4 103.4 103.0 100.3 97.2 

900 155.1 155.1 153.0 145.0 134.0 125.0 

 

Table 11- 24 DIN 11851 [bar] 

PN (bar) / DN Temperature TS (°C) 

-50 0 50 100 140 

25 / 50-100 25 25 25 25 25 

40 / 10-40 40 40 40 40 40 
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11.8 Design 

Table 11- 25 Design  

Description Specification 

Dimension and weight See Dimensions and weight (Page 111)  

Process connectors • EN1092-1 B1, PN16, PN40, PN63, PN100, 
PN160 

• EN1092-1 D (gasket groove), PN40, PN63, 
PN100, PN160 

• ISO 228-1 G * 

• ASME B1.20.1 NPT * 

• ASME B16.5, Cl 150, Cl 300, Cl 600, Cl 900 

• DIN 11851 ** 

• DIN 32676 * 

• DIN 11864-1A **, DIN 11864-2C (inch) **, DIN 
11864-3A ** 

• ISO 2852 ** 

• ISO 2853 ** 

• JIS B 2220, 10K, 20K, 40K, 62K 

Electrical connection • M12 connector with 4-wire cable 

• Standard cable with polymer / brass / stain-
less steel cable glands (metric or NPT) 

• Armored cable with stainless steel armored 
cable glands (metric or NPT) 

• Conduit entries (metric or NPT) 

Material  

 Measuring tubes • AISI 316L / W1.4404 

• Hastelloy C22 / UNS N06022 

 Process connectors • Standard: 

– AISI 316L / W1.4435 or W1.4404 

– Hastelloy C22 / UNS N06022 

• Hygienic: 

– AISI 316L / W1.4435 

 Sensor enclosure AISI 304 / W1.4301 

 Transmitter enclosure Aluminum with corrosion-resistant coating 

Measuring tube design Split flow through 2 parallel tubes with combined 
cross-section area 50% of the nominal pipe 

The measuring tubes are bent in a trapezoidal 
curve 
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Description Specification 

Measuring tube surface roughness • Standard: 1.6 µm 

• Hygienic: 0.8 μm 

Self-draining design Yes, when mounted vertically 

*: Pressure ratings depend on sensor material 
**: Pressure ratings depend on process connection dimension 

11.9 Power supply 

Table 11- 26 Power supply  

Description Specification 

Supply Voltage [V] 24 VDC +/- 20% for non-hazardous duty 
24 VDC +0/-20% for flameproof installation 

Reverse polarity protection Yes 

Power consumption 1.1 W 

  

11.10 Basic electrical requirement for master system 

Table 11- 27 Power unit  

Description Specification 

Protection class Class I (EN60950) 

Galvanic isolation primary/secondary SELV acc. to EN 60950 and EN 50178 or equiva-
lent 

Master/Receiver Isolation 500 VAC 
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11.11 Cables and cable entries 

The following information applies to cables and cable glands supplied as accessories to the 
device. 

Table 11- 28 Power and signal cable, basic data  

Description Specification 

Number of conductors 4 

Square area [mm2] 0.326 (AWG 22/7) 

Screen Common shield for all 4 conductors 

Outside color Gray (RAL 7001) 

External diameter [mm] 6.5 

Maximum length 600 m (1968 ft.) 

Installation environment Industrial including chemical processing plants 

Insulation material  Special polyolefin 

Halogen-free Yes 

RoHS compliant Yes 

Torsional strength • >3 million cycles at ± 180° on 200 mm 

• Not adapted for garland mounting (festoon) 

Permissible temperature range [°C (°F)] -40 to +80 (-40 to +176) 

Min. bending radius allowed Single 5 X ø 

Table 11- 29 Cable glands and entries 

Description Specification 

Glands • Material 

– Nylon1) 

– Brass/Ni plated 

– Stainless steel AISI 316/1.4404 

• Cable cross section 

– ∅ 5 to 10 mm (0.20" to 0.39") 

Entry • 1 x M20 or 1 X NPT ½" for communication 

1): If operating temperature is below -20 °C (-4 °F), use Brass/Ni plated or stainless steel 
cable glands. 

 

 Note 

For hygienic applications (3A & EHEDG) the cable glands and blind plugs must be made 
from corrosion resistant material like nickel brass, stainless steel or plastic. The exposed 
threads must be minimized when they are tightened up on the cable and they must have a 
seal (plastic or rubber) under the threads where they screw into the terminal housing or 
enclosure. 
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11.12 Installation torques 

Table 11- 30 Installation torques  

Description Torque (Nm) 

Pressure guard fittings 80 

Pedestal lock screw cap 10 

Cable gland to housing (Siemens 
supplied, metric) 

10 

 

 Note 

NPT glands 

When using NPT glands, user must take care when packing threads and installing cables 
that sufficient tightness is obtained to prevent ingress of moisture. 

11.13 Certificates and approvals 

Table 11- 31 Certificates and approvals  

Description Specification 

ATEX FC410 flowmeter (can be installed in Zone 1 for gas and Zone 20/21 for 
dust): 
Certificate: SIRA 11ATEX1341X 

 II 1/2 G 
1D 
2D 

For gas: 
Ex d ia IIC T* Ga/Gb  
Ex d IIC T* Ga/Gb 
(Ga/Gb: Zone 0 in pipe and Zone 1 in environment) 

For dust: 
Ex ta IIIC T* °C Da  
Ex tb IIIC T* °C Db 
(Zone 20 ("ta") process and ambient temperature limited in comparison with 
Zone 21 ("tb") 

Ta = -40°C to +60°C 

* Temperature class (dependent on the process temperature and the ambi-
ent temperature, see Special Conditions for Safe Use, Section 2.3) 
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Description Specification 

IECEx FC410 flowmeter (can be installed in Zone 1 for gas and Zone 20/21 for 
dust): 
Certificate: IECEx SIR 11.0149X 

For gas: 
Ex d ia IIC T* Ga/Gb  
Ex d IIC T* Ga/Gb 
(Ga/Gb: Zone 0 in pipe and Zone 1 in environment) 

For dust: 
Ex ta IIIC T* °C Da  
Ex tb IIIC T* °C Db 
(Zone 20 ("ta") process and ambient temperature limited in comparison with 
Zone 21 ("tb") 
(Ta = -40°C to +60°C) 

* Temperature class (dependent on the process temperature and the ambi-
ent temperature, see Conditions of Certification, Section 2.3) 

EAC Ex FC410 flowmeter / -40°C ≤ Tamb ≤ ** °C 

1Ex d ia IIC T* Ga/Gb 

Ex ta IIIC T** °C Da 

Ex tb IIIC T** °C Db 

FM Class I, II, III Division 1 
Groups A, B, C, D, E, F, G  

See Control drawing: A5E31205486A 

Hygienic version 3A 

EHEDG 

EC1935:2004 and 2023:2006 (food contact material: stainless steel) 

Pressure equipment 97/23/EC Pressure Equipment Directive (PED) 

Canadian Registration Number (CRN) 

Marine approval ABS - American Bureau of Shipping (USA) 

BV - Bureau Veritas (France) 

DNV - Det Norske Veritas (Norway) 

GL - Germanischer Lloyd (Germany) 

Lloyds Register (Worldwide) 

11.14 PED 

The pressure equipment directive 97/23/EC applies to the alignment of the statutory orders 
of the European member states for pressure equipment. Such equipment in the sense of the 
directive includes vessels, pipelines and accessories with a maximum allowable pressure of 
more than 0.5 bar above atmospheric. Flowmeters are considered as piping. 

A detailed risk analysis of the flowmeter has been performed in accordance with the PED 
97/23/EC. All risks are assessed to be "none" provided that the procedures and standards 
referenced in these operating instructions are observed. 
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Division according to the danger potential 

Flowmeters, which are categorized as piping, are divided into categories according to danger 
potential (medium, pressure, nominal diameter). The flowmeters fall into the categories I to 
III or they are manufactured according to Article 3 Paragraph 3 - Sound Engineering Practice 
(SEP). 

The following criteria are decisive for assessment of the danger potential, and are also 
shown in Diagrams 6 to 9. 
 

Fluid group Group 1 or 2 

• Aggregate state Liquid or gaseous 

• Type of pressurized equipment 

– Pipeline 

 

Product of pressure and volume (PS * V [barL]) 

The maximum allowable temperature for the used liquids or gases is the maximum process 
temperature which can occur, as defined by the user. This must be within the limits defined 
for the equipment. 

Division of media (liquid/gaseous) into the fluid groups 

Fluids are divided according to Article 9 into the following fluid groups: 

Group 1 fluids 
 

Explosive 

R phrases: for example: 2, 3 (1, 4, 5, 6, 9, 16, 18, 
19, 44) 

 

Very toxic 

R phrases: for example: 26, 27, 28, 39 (32) 
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Extremely flammable 

R phrases: for example: 12 (17) 

 

Toxic 

R phrases: for example: 23, 24, 25 (29, 31) 

 

Highly flammable 

R phrases: for example: 11, 15, 17 (10, 30) 

 

Oxidizing  

R phrases: for example: 7, 8, 9 (14, 15, 19) 

 

Flammable 

R phrases: for example11 (10) 
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Group 2 fluids 

All fluids not belonging to Group 1. 

Also applies to fluids which are for example dangerous to the environment, corrosive, 
dangerous to health, irritant or carcinogenic (if not highly toxic). 

Conformity assessment 

Flowmeters of categories I to III comply with the safety requirements of the directive. They 
are affixed with the CE mark and an EC declaration of conformity is provided. 

The flowmeters are subjected to the conformity assessment procedure - Module H. 

Flowmeters according to Article 3 Paragraph 3 are designed and manufactured in 
accordance with sound engineering practice in Denmark. PED conformity reference is not 
affixed to the CE mark. 

Diagrams 

● Gases of fluid group 1 

● Pipelines according to Article 3 Number 1.3 Letter a) First dash 

● Exception: unstable gases belonging to Categories I and II must be included in Category 
III. 

 

Image 11-3 Diagram 6 

● Gases of fluid group 2 

● Pipelines according to Article 3 Number 1.3 Letter a) Second dash 
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● Exception: liquids at temperatures > 350 °C belonging to Category II must be included in 
Category III. 

 

Image 11-4 Diagram 7 

● Liquids of fluid group 1 

● Pipelines according to Article 3 Number 1.3 Letter b) First dash 

 

Image 11-5 Diagram 8 
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● Liquids of fluid group 2 

● Pipelines according to Article 3 Number 1.3 Letter b) Second dash 

 

Image 11-6 Diagram 9 
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 Spare parts and accessories  12 
12.1 Ordering 

In order to ensure that the ordering data you are using is not outdated, the latest ordering 
data is always available on the Internet: Catalog process instrumentation 
(http://www.siemens.com/processinstrumentation/catalogs) 

12.2 Ex approved products 

 

 
WARNING 

Repair of Ex-approved products 

It is the customer's responsibility that repair of Ex-approved products fulfill national 
requirements. 

 

http://www.siemens.com/processinstrumentation/catalogs
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12.3 Replaceable components 

This table gives an overview of which components can be replaced. 

Table 12- 1 Overview of replaceable components 

Component  Order number Photo and position on  

illustration in Design (Page 22)  

Hot swapable * 

 

SITRANS FC410  
Blind lid small (∅85 mm) 

A5E03549295 

 

 Yes 

Observe hazardous 
area access protocol 

SITRANS FC410  
electronic 
 

A5E03549191 

 

 No 

SITRANS FC410 
Housing metric 

A5E03549313 

 

 No 

SITRANS FCS410 
Housing NPT 

A5E03906080 

 

 No 

SITRANS FC410  
Bag of loose parts for sensor 

A5E03549324 Contents:  
Screws, O-rings, cable 
clamp parts 

  

SITRANS FC410 
M12 option for FC410 housing 

A5E03906095 

 

 No 

* Components may be replaced while power is on in non-hazardous locations only.  
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 Dimensions and weight  13 
13.1 Sensor dimensions 

 

 

Table 13- 1 Basic dimensions  

Sensor DN A in mm (inch) B in mm (inch) C in mm (inch) Weight in kg (lb) 

15 (½") 90 (3.54) 280 (11.0) 90 (3.54) 4.6 (10.1) 

25 (1") 123 (4.84) 315 (12.4) 90 (3.54) 7.9 (17.4) 

50 (2") 187 (7.36) 390 (15.4) 90 (3.54) 25.7 (56.7) 

80 (3") 294 (11.6) 504 (19.8) 90 (3.54) 66.5 (147) 

 

 

 Note 

The build in length (D) depends on the process connector. 
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13.2 Length matrix 

316L stainless steel or Hastelloy - standard 

Table 13- 2 7ME461 - sensor sizes DN15 and DN25 

Sensor DN15 DN25 

Connection DN6 DN10 DN15 DN20 DN25 DN25 DN32 DN40 

EN1092-1 B1, PN16   265 
(10.4) 

 265 
(10.4) 

360 
(14.2) 

 365 
(14.4) 

EN1092-1 B1, PN40   265 
(10.4) 

 265 
(10.4) 

360 
(14.2) 

 365 
(14.4) 

EN1092-1 B1, PN63   265 
(10.4) 

  360 
(14.2) 

  

EN1092-1 B1, PN100   270 
(10.6) 

 275 
(10.8) 

360 
(14.2) 

 365 
(14.4) 

EN1092-1 B1, PN160   270 
(10.6) 

  360 
(14.2) 

  

EN1092-1 D, PN40   265 
(10.4) 

  360 
(14.2) 

  

EN1092-1 D, PN63   265 
(10.4) 

  360 
(14.2) 

  

EN1092-1 D, PN100   270 
(10.6) 

  360 
(14.2) 

  

EN1092-1 D, PN160   270 
(10.6) 

  360 
(14.2) 

  

ANSI B16.5, Class 150   270 
(10.6) 

270 
(10.6) 

 360 
(14.2) 

 365 
(14.4) 

ANSI B16.5, Class 300   270 
(10.6) 

270 
(10.6) 

 360 
(14.2) 

 380 
(15.0) 

ANSI B16.5, Class 600   270 
(10.6) 

285 
(11.2) 

 360 
(14.2) 

 380 
(15.0) 

ANSI B16.5, Class 900   290 
(11.4) 

  385 
(15.2) 

  

ISO 228-1 G Pipe thread 265 
(10.4) 

 265 
(10.4) 

  365 
(14.4) 

  

ANSI B1.20.1 NPT Pipe thread 265 
(10.4) 

 270 
(10.6) 

  365 
(14.4) 

  

DIN 11851 Hygienic screwed  265 
(10.4) 

265 
(10.4) 

 270 
(10.6) 

360 
(14.2) 

360 
(14.2) 

 

DIN 32676-C Hygienic clamp   265 
(10.4) 

265 
(10.4) 

 360 
(14.2) 

 360 
(14.2) 

DIN 11864-1 Aseptic screwed   265 
(10.4) 

  360 
(14.2) 

  

DIN 11864-2A Aseptic flanged   265 
(10.4) 

  360 
(14.2) 

  

DIN 11864-3A Aseptic clamp   265 
(10.4) 

  360 
(14.2) 
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ISO 2852 Hygienic clamp     265 
(10.4) 

360 
(14.2) 

 360 
(14.2) 

ISO 2853 Hygienic screwed     265 
(10.4) 

360 
(14.2) 

 360 
(14.2) 

SMS 1145 Hygienic screwed     265 
(10.4) 

360 
(14.2) 

  

12-VCO-4 Quick connect   285 
(11.2) 

     

JIS B2220 10K   265 
(10.4) 

  360 
(14.2) 

  

JIS B2220 20K   265 
(10.4) 

  360 
(14.2) 

  

JIS B2220 40K   270 
(10.6) 

  360 
(14.2) 

  

JIS B2220 63K   275 
(10.8) 

  370 
(14.6) 

  

 Dimensions in mm (inch) 

Table 13- 3 7ME461 - sensor sizes DN50 and DN80 

Sensor DN50 DN80 

Connection DN40 DN50 DN65 DN80 DN100 

EN1092-1 B1, PN16 610 (24.0) 610 (24.0) 915 (36.0) 840 (33.1) 840 (33.1) 

EN1092-1 B1, PN40 610 (24.0) 610 (24.0) 915 (36.0) 840 (33.1) 840 (33.1) 

EN1092-1 B1, PN63 610 (24.0) 610 (24.0) 915 (36.0) 915 (36.0) 915 (36.0) 

EN1092-1 B1, PN100 610 (24.0) 610 (24.0) 915 (36.0) 915 (36.0) 915 (36.0) 

EN1092-1 B1, PN160  620 (24.4)  915 (36.0)  

EN1092-1 D, PN40 610 (24.0) 610 (24.0)  840 (33.1)  

EN1092-1 D, PN63 610 (24.0) 610 (24.0)  915 (36.0)  

EN1092-1 D, PN100 610 (24.0) 610 (24.0)  915 (36.0)  

EN1092-1 D, PN160  620 (24.4)  915 (36.0)  

ANSI B16.5, Class 150  620 (24.4) 915 (36.0) 875 (34.4)  

ANSI B16.5, Class 300  620 (24.4) 915 (36.0) 875 (34.4)  

ANSI B16.5, Class 600  620 (24.4) 915 (36.0) 875 (34.4)  

ANSI B16.5, Class 900  620 (24.4)  875 (34.4)  

ISO 228-1 G Pipe thread  620 (24.4)    

ANSI B1.20.1 NPT pipe thread  620 (24.4)    

DIN 11851 Hygienic screwed 610 (24.0) 610 (24.0) 840 (33.1) 840 (33.1)  

DIN 32676-C Hygienic clamp  610 (24.0)  875 (34.4)  

DIN 11864-1 Aseptic screwed 610 (24.0) 610 (24.0)  875 (34.4)  

DIN 11864-2A Aseptic flanged 620 (24.4) 610 (24.0)  875 (34.4)  

DIN 11864-3A Aseptic clamp 610 (24.0) 610 (24.0)  840 (33.1)  

ISO 2852 Hygienic clamp 610 (24.0) 610 (24.0)  840 (33.1)  

ISO 2853 Hygienic screwed 630 (24.8) 610 (24.0)  860 (33.9)  

SMS 1145 Hygienic screwed 610 (24.0) 610 (24.0)  875 (34.4)  

12-VCO-4 Quick connect      
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JIS B2220 10K 620 (24.4) 610 (24.0)  840 (33.1)  

JIS B2220 20K 620 (24.4) 610 (24.0)  860 (33.9)   

JIS B2220 40K 620 (24.4) 610 (24.0)  875 (34.4)  

JIS B2220 63K  620 (24.4)  875 (34.4)  

 Dimensions in mm (inch) 

13.3 316L stainless steel - NAMUR 

316L stainless steel - NAMUR 

Table 13- 4 7ME471 - sensor sizes DN15 and DN25 

Sensor DN15 DN25 

Connection DN6 DN10 DN15 DN20 DN25 DN25 DN32 DN40 

EN1092-1 B1, PN16   510 
(20.1) 

 510 
(20.1) 

600 
(23.6) 

 605 
(23.8) 

EN1092-1 B1, PN40   510 
(20.1) 

 510 
(20.1) 

600 
(23.6) 

 605 
(23.8) 

EN1092-1 B1, PN63   510 
(20.1) 

  600 
(23.6) 

  

EN1092-1 B1, PN100   515 
(20.3) 

 520 
(20.5) 

600 
(23.6) 

 605 
(23.8) 

EN1092-1 B1, PN160   515 
(20.3) 

  600 
(23.6) 

  

EN1092-1 D, PN40   510 
(20.1) 

  600 
(23.6) 

  

EN1092-1 D, PN63   510 
(20.1) 

  600 
(23.6) 

  

EN1092-1 D, PN100   515 
(20.3) 

  600 
(23.6) 

  

EN1092-1 D, PN160   515 
(20.3) 

  600 
(23.6) 

  

ANSI B16.5, Class 150   515 
(20.3) 

515 
(20.3) 

 600 
(23.6) 

 605 
(23.8) 

ANSI B16.5, Class 300   515 
(20.3) 

515 
(20.3) 

 600 
(23.6) 

 620 
(24.4) 

ANSI B16.5, Class 600   515 
(20.3) 

530 
(20.9) 

 600 
(23.6) 

 620 
(24.4) 

ANSI B16.5, Class 900   535 
(21.1) 

  625 
(24.6) 

  

ISO228-1 G Pipe thread 510 
(20.1) 

 510 
(20.1) 

  605 
(23.8) 

  

ANSI B1.20.1 NPT Pipe thread 510 
(20.1) 

 515 
(20.3) 

  605 
(23.8) 
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DIN 11851 Hygienic screwed  510 
(20.1) 

510 
(20.1) 

 515 
(20.3) 

600 
(23.6) 

600 
(23.6) 

 

DIN 32676-C Hygienic clamp   510 
(20.1) 

510 
(20.1) 

 600 
(23.6) 

 600 
(23.6) 

DIN 11864-1 Asceptic screwed   510 
(20.1) 

  600 
(23.6) 

  

DIN 11864-2A Asceptic flanged   510 
(20.1) 

  600 
(23.6) 

  

DIN 11864-3A Asceptic clamp   510 
(20.1) 

  600 
(23.6) 

  

ISO 2852 Hygienic clamp     510 
(20.1) 

600 
(23.6) 

 600 
(23.6) 

ISO 2853 Hygienic screwed     510 
(20.1) 

600 
(23.6) 

 600 
(23.6) 

 Dimensions in mm (inch) 
 

Table 13- 5 7ME471 - sensor sizes DN50 and DN80 

Sensor DN50 DN80 

Connection DN40 DN50 DN65 DN80 DN100 

EN1092-1 B1, PN16 715 (28.1) 715 (28.12 915 (36.0) 915 (36.0) 915 (36.0) 

EN1092-1 B1, PN40 715 (28.1) 715 (28.1) 915 (36.0) 915 (36.0) 915 (36.0) 

EN1092-1 B1, PN63 715 (28.1) 715 (28.1) 915 (36.0) 915 (36.0) 915 (36.0) 

EN1092-1 B1, PN100 715 (28.1) 715 (28.1) 915 (36.0) 915 (36.0) 915 (36.0) 

EN1092-1 B1, PN160  725 (28.5)  915 (36.0)  

EN1092-1 D, PN40 715 (28.1) 715 (28.1)  915 (36.0)  

EN1092-1 D, PN63 715 (28.1) 715 (28.1)  915 (36.0)  

EN1092-1 D, PN100 715 (28.1) 715 (28.1)  915 (36.0)  

EN1092-1 D, PN160  725 (28.5)  915 (36.0)  

ANSI B16.5-2009, Class 150  725 (28.5) 915 (36.0) 950 (37.4)  

ANSI B16.5-2009, Class 300  725 (28.5) 915 (36.0) 950 (37.4)  

ANSI B16.5-2009, Class 600  725 (28.5) 915 (36.0) 950 (37.4)  

ANSI B16.5-2009, Class 900  725 (28.5)  950 (37.4)  

ISO228-1 G pipe thread  725 (28.5)    

ANSI B1.20.1 NPT pipe thread  725 (28.5)    

DIN 11851 Hygienic screwed 715 (28.1) 715 (28.1) 915 (36.0) 915 (36.0)  

DIN 32676-C Hygienic clamp  715 (28.1)  950 (37.4)  

DIN 11864-1 Asceptic screwed 715 (28.1) 715 (28.1)  950 (37.4)  

DIN 11864-2A Asceptic flanged 725 (28.5) 715 (28.1)  950 (37.4)  

DIN 11864-3A Aseptic clamp 715 (28.1) 715 (28.1)  915 (36.0)  

ISO 2852 Hygienic clamp 715 (28.1) 715 (28.1)  915 (36.0)  

ISO 2853 Hygienic screwed 735 (28.9) 715 (28.1)  860 (33.9)  

 Dimensions in mm (inch) 
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13.4 Hygienic versions 

316L stainless steel - hygienic version 

Table 13- 6 7ME462 - sensor sizes DN15 and DN25 

Sensor DN15 DN25 

Connection DN6 DN10 DN15 DN20 DN25 DN25 DN32 DN40 

DIN 11851 Hygienic screwed  265 
(10.4) 

265 
(10.4) 

 270 
(10.6) 

360 
(14.2) 

360 
(14.2) 

 

DIN 32676-C Hygienic clamp   265 
(10.4) 

265 
(10.4) 

 360 
(14.2) 

 360 
(14.2) 

DIN 11864-1 Asceptic screwed   265 
(10.4) 

  360 
(14.2) 

  

DIN 11864-2A Asceptic flanged   265 
(10.4) 

  360 
(14.2) 

  

DIN 11864-3A Aseptic clamp   265 
(10.4) 

  360 
(14.2) 

  

ISO 2852 Hygienic clamp     265 
(10.4) 

360 
(14.2) 

 360 
(14.2) 

ISO 2853 Hygienic screwed     265 
(10.4) 

360 
(14.2) 

 360 
(14.2) 

SMS 1145 Hygienic screwed     265 
(10.4) 

360 
(14.2) 

  

 Dimensions in mm (inch) 

Table 13- 7 7ME462 - sensor sizes DN50 and DN80 

Sensor DN50 DN80 

Connection DN40 DN50 DN65 DN80  

DIN 11851 Hygienic screwed 610 (24.0) 610 (24.0) 840 (33.1) 840 (33.1)  

DIN 32676-C Hygienic clamp  610 (24.0)  875 (34.4)  

DIN 11864-1 Asceptic screwed 610 (24.0) 610 (24.0)  875 (34.4)  

DIN 11864-2A Asceptic flanged 620 (24.4) 610 (24.0)  875 (34.4)  

DIN 11864-3A Asceptic clamp 610 (24.0) 610 (24.0)  840 (33.1)  

ISO 2852 Hygienic clamp 610 (24.0) 610 (24.0)  840 (33.1)  

ISO 2853 Hygienic screwed 630 (24.8) 610 (24.0)  860 (33.9)  

SMS 1145 Hygienic screwed 610 (24.0) 610 (24.0)  875 (34.4)  

 Dimensions in mm (inch) 
 

 Note 

3A 

DIN 11851 and ISO 2853 are only 3A-approved if self-centring gaskets are used. 
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Modbus holding registers A 
A.1 Modbus addressing model 

The device allows read/write access to the following standard Modbus RTU data holding 
register blocks: 

● Holding registers (ref. 4x address range) 

The minimum value of a writable holding register can be read by adding 10000 to the 
Modbus address of the register. 

The maximum value of a writable holding register can be read by adding 20000 to the 
Modbus address of the register. 

The default value of a writable holding register can be read by adding 30000 to the Modbus 
address of the register. 

A.2 Modbus function codes 

This device supports following function codes: 3, 8 and 16. 

Function codes 3 and 16 are used for accessing registers, max. 16 registers per read/write 
request is accepted. 

Function code 8 is used for reading Modbus communication diagnostic information. 

Below the various function code are described. 

Function code 3 (Read holding registers) 

General exceptions: 

● Requesting less than 1 or more than 16 registers => Exception 3 (Illegal data value) 

● Requesting invalid start address or start address with invalid quantity => Exception 2 
(Illegal data address) 

Application exceptions: 

● Application errors; min/max limit of parameter exceeded; or parameter write-protected => 
Exception 4 (Slave device error) 

Holes/register alignment: 

● The read command always returns data if no exception is given. 

● Holes in the holding register map return value zero in all bytes. E.g. reading 2 registers 
starting at 4:0004 above will result in 2 bytes of "float B" followed by 2 zeroes. 
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Function code 3 example 

Query 
 

Slave address 1 byte 

Function 1 byte 

Starting Address Hi 1 byte 

Starting Address Lo 1 byte 

Quantity of Registers Hi 1 byte 

Quantity of Registers Lo 1 byte 

CRC 2 bytes 

Response 
 

Slave address 1 byte 

Function 1 byte 

Byte count 1 byte 

Register Value Hi 1 byte 

Register Value Lo 1 byte 

: : 

Register Value Hi 1 byte 

Register Value Lo 1 byte 

CRC 2 bytes 

Example: Read absolute massflow (address 3000) 

Query: 1,3,11,184,0,2,70,10 

Slave address  = 1 (0x01) 
Function = 3 (0x03) 
Starting Address Hi, Lo = 11, 184 (0x0B,0xB8) 
Quantity of Registers Hi , Lo = 0, 2 (0x00,0x02)  
CRC  = 70,10 (0x46, 0x0A) 

Starting address 0x0BB8 = 3000 
Quantity of registers = 0x0002 = 2 

Response: 1,3,4,64,195,82,139,98,200 

Slave address  = 1 (0x01) 
Function = 3 (0x03) 
Byte Count  = 4 (0x04) 
Register 1 - Register Value Hi, Lo = 64, 195 (0x40, 0xC3) 
Register 2 - Register Value Hi, Lo = 82, 139 (0x52,  0x93) 
CRC  = 98,200 (0x62, 0xC8) 

Absolute mass flow = 0x40C35293 = 6.10383 kg/sec 



 Modbus holding registers 

 A.2 Modbus function codes 

FC410 with Modbus 

Operating Instructions, 02/2016, A5E33120874-AC 119 

Function code 16 (Write multiple registers) 

General exceptions 

● Writing less than 1 or more than 16 registers => Exception 3 (Illegal data value) 

● If ByteCount is not exactly 2 times NoOfRegisters => Exception 3 (Illegal data value) 

● Requesting invalid start address or start address with invalid quantity => Exception 2 
(Illegal data address) 

Application exceptions: 

● Application errors; min/max limit of parameter exceeded; or parameter write-protected => 
Exception 4 (Slave device error) 

● Application errors include writing to ReadOnly holding registers 

Holes/register alignment: 

● If start-address is not the start of a mapped holding register => Exception 2 (Illegal data 
address) 

● Writing to holes is allowed (ie ignored - and no exception occurs) - except for the 
condition described above 

● If the end address is only part of a mapped holding register item (e.g. one half of a float 
value), the action depends on the data type. Writing parts of all data types => Exception 4 
(Slave device error) 

Function code 16 example 

Query 
 

Slave address 1 byte 

Function 1 byte 

Starting Address Hi 1 byte 

Starting Address Lo 1 byte 

Quantity of Registers Hi 1 byte 

Quantity of Registers Lo 1 byte 

Byte Count 1 byte 

Registers Value Hi 1 byte 

Registers Value Lo 1 byte 

: : 

Registers Value Hi 1 byte 

Registers Value Lo 1 byte 

CRC 2 bytes 
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Response 
 

Slave address 1 byte 

Function 1 byte 

Starting Address Hi 1 byte 

Starting Address Lo 1 byte 

Quantity of Registers Hi 1 byte 

Quantity of Registers Lo 1 byte 

CRC 2 bytes 

Example: Set baud rate to 115200 baud (address 529) 

Query: 1,16,2,17,0,1,2,0,5,70,210 

Slave address  = 1 (0x01) 
Function = 16 (0x10) 
Starting Address Hi, Lo = 2, 17 (0x02,0x11)  
Quantity of Registers Hi, Lo = 0, 1 (0x00,0x01) 
Byte Count  = 2 (0x02) 
Registers Value Hi, Lo = 0, 5 (0x00,0x05) 
CRC  = 70,10 (0x46, 0x0A) 

Starting address 0x0211 = 529 
Number of registers = 0x0001 = 1 
Data 0x0005 = (115200 = value 5) 

Response: 1,16,2,17,0,1,80,116 

Slave address  = 1 (0x01) 
Function = 16 (0x10) 
Starting Address Hi, Lo = 2, 17 (0x02,0x11) 
Quantity of Registers Hi, Lo = 0, 1 (0x00,0x01)  
CRC = 80,116 (0x50, 0x74) 

Function code 8 (Diagnostics) 

Modbus function code 8 provides a series of tests for checking the communication system 
between a client (Master) device and a server (Slave). 

The following diagnostics functions are supported: 
 

Sub-
function 
code 
(Dec) 

Name Description 

00 Return Query Data The data passed in the request data field is to be returned 
(looped back) in the response. 

10 Clear Counters and  
Diagnostic Register 

Clears all counters and the diagnostic register. Counters 
are also cleared upon power–up. 

11 Return Bus Message Count The response data field returns the quantity of messages 
that the remote device has detected on the communications 
system since its last restart, clear counters execution, or 
power–up. 
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Sub-
function 
code 
(Dec) 

Name Description 

12 Return Bus Communication 
Error Count 

The response data field returns the quantity of CRC errors 
encountered by the remote device since its last restart, 
clear counters execution, or power–up. 

13 Return Bus Exception Error 
Count 

The response data field returns the quantity of MODBUS 
exception responses returned by the remote device since 
its last restart, clear counters execution, or power–up. 

14 Return Slave Message 
Count 

The response data field returns the quantity of messages 
broadcast or addressed to the remote device that the  
remote device has processed since its last restart, clear 
counters execution, or power–up. 

15 Return Slave No Response 
Count 

The response data field returns the quantity of messages 
addressed to the remote device for which it has returned no 
response (neither a normal response nor an exception 
response), since its last restart, clear counters execution, or 
power–up. 

16 Return Slave NAK Count The response data field returns the quantity of messages 
addressed to the remote device for which it returned a  
Negative Acknowledge (NAK) exception response, since its 
last restart, clear counters execution, or power–up. 

17 Return Slave Busy Count The response data field returns the quantity of messages 
addressed to the remote device for which it returned a Sla-
ve Device Busy exception response, since its last  
restart, clear counters execution, or power–up. 

18 Return Bus Character  
Overrun Count 

The response data field returns the quantity of messages 
addressed to the remote device that it could not handle due 
to a character overrun condition, since its last restart, clear 
counters execution, or power–up. 

20 Clear Overrun Counter and 
Flag 

Clears the overrun error counter and resets the error flag. 

Function code 8 example 

Query 
 

Slave address 1 byte 

Function 1 byte 

Sub-function Hi 1 byte 

Sub-function Lo 1 byte 

Data Hi 1 byte 

Data Lo 1 byte 

: : 

Data Hi 1 byte 

Data Lo 1 byte 

CRC 2 bytes 
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Response 
 

Slave address 1 byte 

Function 1 byte 

Sub-function Hi 1 byte 

Sub-function Lo 1 byte 

Data Hi 1 byte 

Data Lo 1 byte 

: : 

Data Hi 1 byte 

Data Lo 1 byte 

CRC 2 bytes 

Example: Read Return Slave Message Count (address 529) 

Query: 1,8,0,14,0,0,129,200 

Slave address  = 1 (0x01) 
Function = 8 (0x08) 
Sub-function Hi, Lo = 0, 14 (0x00,0x0E) 
Data Hi, Lo = 0, 0 (0x00,0x00) 
CRC  = 129,200 (0x81, 0xC8) 

Sub-function 0x000E = 14 = Read Return Slave Message Count 

Response: 1,8,0,14,0,97,64,32 

Slave address  = 1 (0x01) 
Function = 8 (0x08) 
Sub-function Hi, Lo = 0, 14 (0x00,0x0E) 
Data Hi, Lo = 0, 97 (0x00,0x65) 
CRC  =  64,32 (0x41, 0xE3) 

Read Return Slave Message Count = 0x0065 = 97 message received 

A.3 Modbus holding registers tables 

In the following the Modbus RTU holding registers available for FC410 are described. 
 

 Note 

All Write parameters require password access. 
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A.3.1 Process values 

Table A- 1 Process values  

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

3000 float / 4 Massflow Measured massflow - [kg/s] - Read Only 

3002  float / 4 Volumeflow Measured volumeflow - [m3/s] - Read Only 

3004 float / 4 Density Measured density - [kg/m3] - Read Only 

3010 float / 4 Temperature Measured temperature of 
the process media 

- [°C] - Read Only 

3023 float / 4 Frame Tempera-
ture 

Measured temperature of 
the sensor frame 

- [°C] - Read Only 

A.3.2 Identification 

Table A- 2 FC410  

Modbus 
address 

Data type / 
Size (bytes) 

Parameter Description Default value 
(unit) 

Value range Access 
level 

4000 String / 20 Manufacturer Device manufacturer Siemens - Read Only 

4020 String / 10 Sensor Firmware 
Revision  

Sensor firmware version - - Read Only 

4025 String / 16 SensorType Sensor type.  

Also shown on the device 
nameplate 

SITRANS 
FC410 

- Read Only 

4033 String / 20 Sensor Serial Num-
ber  

Unique sensor serial num-
ber.  

Also shown on the device 
nameplate 

- - Read Only 

4095 String / 10 Sensor Hardware 
Revision  

Sensor hardware version - - Read Only 

4100 String / 10 Sensor Frontend 
Type 

Sensor hardware variant - - Read Only 

4121 String / 20 Sensor Order Num-
ber 

Sensor order number part 1 
(MLFB).  

Also shown on the device 
nameplate 

- - Read Only 

4131  String / 32 Sensor Order Num-
ber 

Sensor order number part 2 
(MLFB).  

Also shown on the device 
nameplate 

- - Read Only 

4147  String / 32 Sensor Order Num-
ber 

Sensor order number part 3 
(MLFB).  

Also shown on the device 
nameplate 

- - Read Only 
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Modbus 
address 

Data type / 
Size (bytes) 

Parameter Description Default value 
(unit) 

Value range Access 
level 

4164 String / 32 Long TAG Enter a unique TAG name 
for the device (up to 32 
characters) 

   

4180 String / 16 Descriptor Enter a unique description 
for the measurement point 
(up to 16 characters) 

   

4188 String / 16 Startup Date Enter the installation date of 
the device 

   

A.3.3 Setup 

Table A- 3 Operating conditions  

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2100 Unsigned / 
2 

Flow Direction Define positive and negative 
flow direction.  

Default positive flow direction is 
indicated by the arrow on the 
sensor. 

Possible selections: 

• 0: Negative: The flow is 
measured '+' in default ne-
gative direction and '-' in 
default positive direction. 

• 1: Positive: The flow is 
measured '+' in default po-
sitive direction and '-' in 
default negative direction 

1 0 to 1 Read / 
Write 

2130 Unsigned / 
2 

Process Noise 
Damping 

Select process noise damping 
level: 

0: 55 ms filtering  
(Centrifugal Pump) 
1: 110 ms filtering  
(Triplex Pump)  
2: 220 ms filtering  
(Duplex Pump) 
3: 400 ms filtering  
(Simplex Pump) 

4: 800 ms filtering  
(Cam Pump) 

2 0 Low to 4 
High 

Read / 
Write 
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Table A- 4 Massflow  

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2125 Float / 4 Low Massflow Cut-
Off  

Set massflow limit for low 
flow cut-off. 

Below this limit massflow 
output is forced to zero. 

If Low Flow Cut-Off is set to 
0, the cut-off functionality is 
disabled. 

Notice:  

It is recommended to set a 
lower value for gas applica-
tions. 

Sensor size 
specific [kg/s] 
1) 

0 to 1023 Read / 
Write 

2426 Float / 4 Massflow Correction 
Factor 

Specify correction factor for 
use in the massflow calcula-
tion 

1 -1.999 to 
+1.999 

Read / 
Write 

1): See Sensor dimension dependent default settings (Page 139) 

Table A- 5 Volume flow  

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2170 Float / 4 Low Volumeflow 
Cut Off 

Define the numerical volume-
flow value below which the 
volume flow output is forced 
to zero. 

Sensor size 
specific [m3/s] 
1) 

0 to 0.177 Read / 
Write 

1): See Sensor dimension dependent default settings (Page 139) 

Table A- 6 Density  

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2127 Float / 4 Empty Tube Limit Define threshold value of 
empty tube 

500 [kg/m3] -14 000 to 
+14 000 

Read / 
Write 

2129 Unsigned / 
2 

Empty Tube  
Detection 

Set automatic detection of 
Empty Tube On/Off 
 
0 = off (Empty tube is off). 
1 = on (a density value 
below Empty Tube Limit 
triggers an alarm. All flow 
rate values are forced to 
zero %). 

0 0 to 1 

 

Read / 
Write 
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Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2442 Float / 4 Density Correction 
Factor  

Set density compensation 
value (gain) in order to 
make a density correction 
(scale factor). 

To increase the displayed 
density value with +0.5 %, 
set the density factor to 
1.005. 

The displayed density value 
will now be 0.5 % higher 
than before 

1 -1.999 to 
+1.999 

Read / 
Write 

2444 Float / 4 Density Correction 
Offset 

Set density compensation 
value (offset) in order to 
make an offset on the mea-
sured density. 

To make the flowmeter 
show + 2 kg/m3, change the 
density offset to 2.000 kg/m3 
in the 'Sensor' menu 

0 [kg/m3] -1 400 to +1 
400 

Read / 
Write 

  

A.3.4 Totalizer 

Table A- 7 Totalizer  

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default 
value [unit] 

Value range Access 
level 

2609 unsigned / 
2 

Totalizer State Totalizer state  

• 0 = paused 

• 1= running 

1 0 to 1 Read only 

2610 float / 4 Totalizer Value The totalized MASS value in 
kg 

0 [kg] Min. -1.70E+38  

Max. 1.70E+38 

Read Only 
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Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default 
value [unit] 

Value range Access 
level 

3018 Unsigned / 
4 

Totalizer fixed 
point part 

The totalized MASS value in 
kg. Most significant word of 
the totalizer (MSW). 

The format of the totalizer is 
a TotalType.  
The TotalType represent a 
fixed point value in the 
MSW 32 bit and a fractional 
part in the LSW 32 bit. 

Example: 2.03 would be 
represented as fixed point 
part = 2 and fractional part = 
30000000 

Note: the data type is  
unsigned32, but shall be 
converted into a signed32 
by the host since signed32 
is not supported in the  
device. 

Example conversion to 
float64 tag by the host: 
Float64 tag = fixed point 
part + (fraction 
part/1000000000.0); 

0 [kg] 

 

Min -
2147483648 

Max 
2247483647 

 

Read Only 

3020 Unsigned / 
4 

Totalizer fractional 
part 

The totalized MASS value in 

kg. Least significant word of 
the totalizer (LSW). 

The format of the totalizer is 
a TotalType. 
The TotalType represent a 
fixed point value in the 
MSW 32 bit and a fractional 
part in the LSW 32 bit. 

Example: 2.03 would be 
represented as fixed point 
part = 2 and fractional part = 
30000000 

Note: the data type is  
unsigned32, but shall be 
converted into a signed32 
by the host since signed32 
is not supported in the  
device. 

Example conversion to 
float64 tag by the host: 
Float64 tag = fixed point 
part + (fraction 
part/1000000000.0); 

0 [kg] Min -999999999 

Max 999999999 

 

Read Only 

2612 unsigned / 
2 

Reset totalizer Reset totalizer Value - Enter 1 to reset Read / 
Write 
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Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default 
value [unit] 

Value range Access 
level 

2613 unsigned / 
2 

Pause totalizer Pause totalizer 

Totalizer can only be pau-
sed when running  

- Enter 1 to pause Read / 
Write 

2614 unsigned / 
2 

Resume totalizer Resume totalizer 

Totalizer can only be  
resumed when paused 

- Enter 1 to pause Read / 
Write 

  

A.3.5 Maintenance & Diagnostics 

Table A- 8 Access level  

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

404 Unsigned / 
2 

Access level Access level status - 32 (logged 
in) 

4 (logged 
out) 

Read Only 

412 Unsigned / 
2 

User password Password to enable writing 
commands 

- 2457 (enab-
le user 
password 

0 (disable 
user pass-
word) 

Read / 
Write 

 

Table A- 9 Maintenance  

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

700 Unsigned / 
2 

Set To Default Reset all parameters to 
factory settings 

- Enter 1 to 
reset 

Write 

2700 Unsigned / 
4 

Operating Time Total Total operating time since 
first power up 

0 [h] - Read Only 

2702 Unsigned / 
4 

Operating Time  Operating time since last 
power up 

0 [h] - Read Only 

4088 String / 14 Firmware Time 
Stamp 

Firmware time stamp  
specifies the date and time 
when the sensor firmware 
was built 

- - Read Only 

4105 String / 32 Sensor PCBA Serial 
Number 

Serial number of the sensor 
electronic 

- - Read only 
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Table A- 10 Device diagnostics 

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2756 Float / 4 Driver Current Actual sensor driver current. 

The actual driver current is 
viscosity and sensor size 
dependent 

- [A] 0 to 0.124 Read Only 

2758 Float / 4 Pick-up Amplitude 1 Actual pick-up 1 amplitude - [V] 0 to 0 9999 Read Only 

2760 Float / 4 Pick-up Amplitude 2 Actual pick-up 2 amplitude - [V] 0 to 0 9999 Read Only 

2762 Float / 4 Sensor Frequency Actual sensor frequency - [Hz] 0 to 1 023 Read Only 

3032 Float / 4 PCB Temperature 
 

Actual sensor electronic 
temperature 

- [C°] -50 to 200  Read Only 

 

Table A- 11 Aerated flow 

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2200 Unsigned / 
2 

Aerated Flow Alarm 
Limit 
 
 

Alarm limit calculated in per 
cent of accepted bad  
measurements. 

80 [%] 0 to 99 Read / 
Write 

2201 Unsigned / 
2 

Aerated Flow Warn-
ing Limit 

Warning limit calculated in 
per cent of accepted bad 
measurements 

0 [%] 0 to 99 Read / 
Write 

2202 Unsigned / 
2 

Measurement Samp-
le Time 

The time period over which 
the actual percentage of 
bad measurements is  
calculated 

5 [s] 1 to 10 Read / 
Write 

2203 Unsigned / 
2 

Aerated Flow Filter Aerated flow filter 

0: Disabled 
1: Enabled 
2: Auto 
Auto means that filtering 
starts automatically when 
aerated flow is measured. 

2 0 to 2 Read / 
Write 

2204 Unsigned / 
2 

Filter Time Constant PV Filter Time Constant 

0: 0.5 seconds 
1: 1 second 
2: 2 seconds 
3: 5 seconds 
4: 10 seconds 
5: 20 seconds 
6: 30 seconds 
7: User Defined Value 

4  0 to 7 Read / 
Write 

2205 Float / 4 Filter Start Hystere-
sis 

The filter is active when the 
hysteresis value is  
exceeded. 

Aerated Flow Filter must be 
set to Auto 

0.015 [V] 0 to 0.124 Read / 
Write 
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Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2207 Unsigned / 
2 

Minimum Filtering 
Time 

The filtering time is reset 
each time hysteresis band is 
exceeded 

10 [ms cycles] 0 to 65535 
 

Read / 
Write 

2214 Unsigned / 
2 

Pickup Amplitude 
Filter 

Enable/disable pickup  
amplitude filter. 
0 = Disable 
1 = Enable 

1 0 to 1 Read / 
Write 

2215 Unsigned / 

2 

Bad Measurement 
Count 

Number of bad measure-
ments counted during the 
last period 

0 0 - 65535 Read Only 

2216 Unsigned / 

2 

Filter Iteration Set the number of times to 
repeat the same filter.  
Increasing the number will 
increase the damping. 

Active only if Filter Time 
Constant is set to 7. 

3 1 to 5 Read / 

Write 

2217 Unsigned / 

2 

Bandwidth Factor Increase the Bandwidth 
Factor to reduce the LP (low 
pass) bandwidth filtering. 

Active only if Filter Time 
Constant is set to 7. 

2 0 to 4 Read / 

Write 

2218 Unsigned / 

2 

Filter Pole Shift Configure the bandwidth 
and damping in the stop 
band. A high number will 
give a small bandwidth and 
an increased damping in the 
stop band. 

Active only if Filter Time 
Constant is set to 7. 

2 1 to 5 Read / 

Write 

 

Table A- 12 Zero point adjustment 

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2132 Unsigned / 
2 

Zero Point  
Adjustment 

Select zero-point adjust-
ment method. Automatic 
zero point adjustment is 
recommended. 

• 0 = Auto 

• 1 = Manual 

0 0 to 1 Read / 
Write 

2133 Float / 4 Manual Zero Point 
Offset 

Enter agreed zero point 
offset value for manual zero 
point adjustment mode. 

0 [kg/s] 0 to 1023 

 

Read / 
Write 

2135 Unsigned / 
2 

Zero Point Duration Define duration of zero point 
adjustment. 

30 [s] 1 to 999 Read / 
Write 

2136 Float / 4 Standard Deviation Standard deviation during 
auto zero point adjustment 

0 [kg/s] -1023 to 
+1023 

Read only 
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Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2138 Float / 4 Standard Deviation 
Limit 
 

Set limit for zero point ad-
justment Standard Deviation 
value. If the Standard De-
viation exceeds the  
Standard Deviation Limit, 
the auto zero point adjust-
ment is aborted. 

Sensor size 
specific [kg/s] 
1) 

0 to +1023 Read / 
Write 

2140 Float / 4 Zero Point Offsett 
Limit 

Set limit for zero point off-
set. 

If the zero point offset  
exceeds the zero point 
offset limit, the zero point 
offset cannot be stored 

Sensor size 
specific [kg/s] 
1) 

-1023 to 
+1023 

Read / 
Write 

2142 Float / 4 Zero Point Offset 
Value 

Default zero point offset 
based on factory calibration 
of sensor.  

A Zero point offset compen-
sates for sensor variations 
due to process conditions. 

0 [kg/s] -1023 to 
+1023 

Read only 

2144 Unsigned / 
2 

Zero Point Adjust 
Progress 

Shows the progress of the 
currently running Zero Point 
adjustment in percentage 

0 [%] 0 to 100 Read Only 

2145 Unsigned / 
2 

Zero Point Adjust 
Status 

Status of the last zero point 
adjustment performed 
Every high bit ('1')  
represents an error  
occurred in the last zero 
point adjustment performed. 
 
No high bits equals ok. 
Bit 0 = Zero sigma limit 
exceeded 
Bit 1 = Zero offset limit  
exceeded 
Bit 2 = Quality of zero point 
conditions  

- • 1 

• 2 

• 4 

Read Only 

2180 Unsigned / 
2 

Start Zero Point 
Adjustment 

Start automatic zero point 
adjustment. 

The automatic zero point 
adjustment determines the 
application specific zero 
point offset automatically. 

Possible selections: 

• 0: Idle 

• 1: Running 

• 2: Start 

0 0 to 2 Read / 
Write 

1): See Sensor dimension dependent default settings (Page 139) 
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A.3.6 Communication 

Table A- 13 Modbus  

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

527 Unsigned / 
2 

Float byte order 
 

The float byte order used in 
Modbus messages. 
 
Selection 0: Byte order:  
1-0-3-2 
Selection 1: Byte order:  
0-1-2-3 
Selection 2: Byte order:  
2-3-0-1 
Selection 3: Byte order:  
3-2-1-0 
 
The first mentioned byte is 
the first byte sent. 
Byte 3 corresponds to the 
left-most byte (MSB) of a 32 
bit float in big endian format; 
byte 0 corresponds to the 
right-most byte (LSB). 

3 0 to 3 Read / 
Write 

528 Unsigned / 
2 

Modbus Address Set Modbus Device 
Address 

1 1 to 247 Read / 
Write 

529 Unsigned / 
2 

Baudrate Set communication  
baudrate. 

Following baud rates are 
available: 

• 0 = 9 600 

• 1 = 19 200 (Default) 

• 2 = 38 400 

• 3 = 57 600 

• 4 = 76 800 

• 5 = 115 200 

1  0 to 5 Read / 
Write 
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Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

530 Unsigned / 
2 

Modbus Parity  
Framing 

RS 485 parity and framing 
8 data bits are always used 
 
0 = even parity, 1 stop bit 
1 = odd parity, 1 stop bit 
2 = no parity, 2 stop bits 

0 0 to 2 Read / 
Write 

600 Unsigned / 
2 

Restart  
communication 

 

Restart Modbus  
communication 

Write: 

• 0 = No effect 

• 1 = Restart 

Read: 

• Always 0 

- 0 to 1 Write 

 

A.3.7 Characteristics 

Table A- 14 Sensor  

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2113 Float / 4 Minimum Frame 
Temperature 

Lower limit of the frame 
temperature 

-50 [°C]   Read only 

2115 Float / 4 Maximum Frame 
Temperature 

Lower limit of the frame 
temperature 

200 [°C]  Read only 

4043 String / 16 Sensor size Nominal sensor diameter 
(DN) 

- - Read only 

4053 String / 16 Hazardous area 
approval 

Hazardous area approval of 
the sensor 

- - Read only 

4078 String / 16 Wetted materials Sensor enclosure material - - Read Only 

 

Table A- 15 Volumeflow calibration 

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2103 Float / 4 Maximum Volume-
flow Capacity 

Maximum volumeflow 
measurement capacity of 
the sensor 

Sensor size 
specific [m3/s] 
1) 

0 to 0.177 Read only 

1): See Sensor dimension dependent default settings (Page 139). 
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Table A- 16 Massflow calibration 

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2101 Float / 4 Maximum Massflow 
Capacity 

Maximum massflow 
measurement capacity of 
the sensor 

Sensor size 
specific [kg/s] 
1) 

0 to 1023 Read only 

2402 Float / 4 Calibration Factor Factory-set sensor-specific 
calibration factor. 
The calibration factor is 
shown on the sensor name-
plate 

- Min: 
5.00E+07 

Max: 
4.29E+09 

Read only 

1): See Sensor dimension dependent default settings (Page 139). 

Table A- 17 Density calibration  

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2428 Float / 4 Density Calibration 
Offset 

Specify an offset in the 
density flow calculation 

- -14 000 to 
+14 000 

Read only 

2430 Float / 4 Density Calibration 
Factor  
 

Specify gain factor in the 
density flow calculation 

 
-  
 
 

-1-999 to 
+1.999 

Read only 

2432 Float / 4 Dens. Comp. Tube 
Temp. 

Specifies a tube tempera-
ture coefficient in the densi-
ty calculation 

- -0.001953 
to 
+0.001953 

Read only 

2434 Float / 4 Dens. Comp. Frame 
Temp. 
 

Specifies a frame tempera-
ture coefficient in the densi-
ty calculation 

- -0.001953 
to 
+0.001953 

Read only 
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A.3.8 Simulation 

Table A- 18 Simulation  

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

2764 Float / 4 Massflow Simulation 
Value 

Set massflow simulation 
value.  

The massflow will be set to 
this value on all outputs, if 
Simulation Mass Flow is 
enabled 

0 [kg/s] -1023 to 
+1023 

Read / 
Write 

2766 Float / 4 Density Simulation 
Value 

Set density simulation  
value.  

The density will be set to 
this value on all outputs, if 
Simulation Density is  
enabled 

1000 [kg/m3] -20000 to 
+20000 

Read / 
Write 

2768 Float / 4 Tube Temperature 
Simulation Value 

Set tube temperature  
simulation value.  

The tube temperature will 
be set to this value on all 
outputs if Simulation Tube 
Temperature is enabled 

0 [°C] -50 to +200 Read / 
Write 

2770 Float / 4 Frame Temperature 
Simulation Value 

Set frame temperature 
simulation value.  

The frame temperature will 
be set to this value on all 
outputs if Simulation Frame 
Temperature is enabled 

0 [°C] -50 to +200 Read / 
Write 

2772 Float / 4 Volumeflow  
Simulation Value 

Set volume flow simulation 
value.  

The volume flow will be set 
to this value on all outputs, 
if Simulation Volume Flow is 
enabled 

m3/s -65 to +65 Read / 
Write 

2780 Unsigned / 
2 

Enable Simulation Activate simulation. 

Select one of the following 
values: 

• Bit 0: Massflow 

• Bit 1: Density 

• Bit 2: Volumeflow 

• Bit 3: Tube temperature 

• Bit 4: Frame tempera-
ture 

0  0 to 63 Read / 
Write 
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A.3.9 Alarms 

Table A- 19 Alarms  

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

3012 Unsigned / 
4 

Alarm Group 1 The following bit is set in case of 
active alarm: 

• Bit 4: 
Power Supply Malfunction 

• Bit 6: 
Temperature Circuit  
Malfunction 

• Bit 10:  
Measurement Out Of Range 

• Bit 14: 
Calibration Malfunction 

• Bit 15: 
Compensation Out Of Range 

• Bit 17: 
Pickup Malfunction 

• Bit 23: 
Driver Malfunction 

• Bit 26: 
Measurement Out Of Range 

• Bit 27: 
Mass Flow Max Limit  
Exceeded 

• Bit 28: 
Volume Flow Max Limit  
Exceeded 

• Bit 29: 
Density Max Limit Exceeded 

• Bit 30: 
Min Tube Temp Exceeded 

• Bit 31: 
Max Tube Temp Exceeded 

- - Read Only 
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Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value 
[unit] 

Value range Access 
level 

3014 Unsigned / 
4 

Alarm Group 2 The following bit is set in case of 
active alarm: 

• Bit 0: 
Min Frame Temp Exceeded 

• Bit 1: 
Max Frame Temp Exceeded 

• Bit 2: 
Zero Sigma Limit Exceeded 

• Bit 3: 
Zero Offset Limit Exceeded 

• Bit 4: 
Quality Of Zero Point  
Conditions 

• Bit 5: 
Empty Pipe 

• Bit 6: 
Sensor Partially Filled 

• Bit 7: 
Storage Malfunction 

• Bit 8: 
System Internal 

• Bit 14: 
Unstable Measurement  
Conditions 

• Bit 15: 
Auto-filtering enabled 

• Bit 23: 
Sensor Startup 

- - Read Only 
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A.3.10 Quality codes for process values 

Table A- 20 Quality code for process values  

Modbus 
address 

Data type / 
Size [bytes] 

Parameter Description Default value [unit] Value range Access 
level 

3014 Unsigned / 
4 

Alarm Group 2 Quality code of a 
measured value 

Process values for 
quality codes 

Media temperature 
Density 
Volume flow 
Mass flow 

Quality code for each 
process value consist 
of 2 bits: 

Bit 24/25: 
Media temperature 

Bit 26/27: 
Density 

Bit 28/29: 
Volume flow 

Bit 30/31: 
Mass flow 

11 Good 

01 Reserved 

10 Simulation 

00 Bad 

Read Only 
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Sensor dimension dependent default settings B 
 

 

Massflow 
 

Sensor dimension Default value Unit Range 

Low Flow Cut-Off 

DN 15 0.00884 kg/s 0 to +8.84 

DN 25 0.0245 kg/s 0 to +24.5 

DN 50 0.0982 kg/s 0 to +98.2 

DN 80 0.251 kg/s 0 to +351 

Volumeflow 
 

Sensor dimension Default value Unit Range 

Low Flow Cut-Off 

DN 15 0.00000884 m3/s 0 to +0.00884 

DN 25 0.0000245 m3/s 0 to +0.0245 

DN 50 0.0000982 m3/s 0 to +0.0982 

DN 80 0.000251 m3/s 0 to +0.251 

Zero Point Adjustment 
 

Sensor dimension Default value Unit Range 

Standard Deviation Limit 

DN 15 0.0004 kg/s  

DN 25 0.004 kg/s  

DN 50 0.015 kg/s  

DN 80 0.019 kg/s  

Offset Limit 

DN 15 0.031944444 kg/s  

DN 25 0.010277778 kg/s  

DN 50 0.144444444 kg/s  

DN 80 0.377777778 kg/s  
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Zero point adjustment C 
 

 

In the following the automatic zero point adjustment function is described. For further details, 
see Zero point adjustment. 

 

 Note 

Preconditions 

Before a zero point adjustment is initiated, the pipe must be flushed, filled and at an absolute 
flowrate of zero preferably also at operating pressure and temperature. Refer to appendix 
Zero point adjustment for more details. 

 

 Note 

Change of parameters during zero point adjustment 

Do not change any other parameter during the zero point adjustment procedure. 

 

Automatic zero point adjustment  

The device measures and calculates the correct zero point automatically. 

The automatic zero point adjustment of the flowmeter is set by the following parameters: 

● Duration (Modbus address 2135) 

● Start Zero Point Adjustment (Modbus address 2180) 

When zero adjust is initiated by selecting Start Zero Point Adjustment, the massflow values 
are acquired and totalized for the configured period (Duration). The default zero point 
adjustment period (30 s.) is normally sufficient for a stable zero point measurement.  

 

 Note 

Extremely low flow quantity 

If the flow quantity is extremely small, extremely precise measurement is necessary. In this 
case, a long zero point adjustment period can be selected for improved zero point 
adjustment. 
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Zero point calculation 

During zero point adjustment, an average value is automatically calculated using the 
following formula: 
 

Zero Point Offset Value 

Average of N flow values 

 

xi is an instantaneous flow value sampled in 
the time domain 

N = Number of samples during zero point 
adjustment 

The offset value must be within the determined Zero Point Offset Limit (Modbus address 
2140). 

 

 Note 

Exceeded zero point offset limit 

If the offset value is greater than the configured limit, proceed as follows: 

• Check that the tube is completely filled and that the flowrate is absolute zero. 

• Check the validity of the configured zero point offset limit. 

• Repeat the zero point adjustment. 

 

Zero point standard deviation 

After completion of the procedure, the standard deviation is calculated in accordance with 
the following formula: 
 

Zero Point Standard Deviation 

Standard deviation of N values 

 

The standard deviation contains important feedback on the homogeneity of the fluid, for 
example on the presence of bubbles or particles. 
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The standard deviation must be within the determined Standard Deviation Limit (Modbus 
address 2138).  

 

 Note 

Exceeded standard deviation limit 

If the standard deviation is greater than the configured limit, proceed as follows: 

• Check that the tube is completely filled and that the flow rate is absolute zero. 

• Check that the installation is vibration-free. 

• Check the validity of the configured standard deviation limit in parameter 2.6.4 Standard 
Deviation Limit. 

• Repeat the zero point adjustment. 

 

Successful automatic zero point adjustment 

If the new zero point offset value is valid, it is automatically stored as the new zero point for 
the sensor. It remains stored in the case of a power failure. 

Manual zero point adjustment 

In case an automatic zero point adjustment cannot be performed, it is possible to do a 
manual zero point adjustment by entering the zero point offset value. 

1. Select Modbus address 2132 Zero Point Adjustment and set the value to 1 = Manual 
Zero Point Adjustment. 

2. Select Modbus address 2133 Manual Zero Point Offset and enter the desired offset 
value. 

See also 

Zero point adjustment (Page 141) 
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CRC calculation D 
 

 

The Cyclical Redundancy Checking (CRC) field is two bytes, containing a 16–bit binary 
value. The CRC value is first generated by the transmitting device, which appends the CRC 
to the message. The receiving device recalculates a CRC during receipt of the message, 
and compares the calculated value to the actual value it received in the CRC field. If the two 
values are not equal an error occurs.  

In the following a short text description of how the CRC is calculated is provided. This 
description is then followed by a C programming example.  

CRC calculation 

1. Load a 16–bit register with FFFF hex (all 1’s). Call this the CRC register. 

2. Exclusive OR the first 8–bit byte of the message with the low–order byte of the 16–bit 
CRC register, putting the result in the CRC register. 

3. Shift the CRC register one bit to the right (toward the LSB), zero–filling the MSB. Extract 
and examine the LSB. 

4. (If the LSB was 0): Repeat Step 3 (another shift).  (If the LSB was 1): Exclusive OR the 
CRC register with the polynomial value 0xA001 (1010 0000 0000 0001). 

5. Repeat Steps 3 and 4 until 8 shifts have been performed. When this is done, a complete 
8–bit byte will have been processed. 

6. Repeat Steps 2 through 5 for the next 8–bit byte of the message. Continue doing this until 
all bytes have been processed. 

7. The final content of the CRC register is the CRC value. 

8. When the CRC is placed into the message, its upper and lower bytes must be swapped 
as described below. 

Placing the CRC into the Message 

When the 16–bit CRC (two 8–bit bytes) is transmitted in the message, the low-order byte will 
be transmitted first, followed by the high-order byte. 

For example, if the CRC value is 1241 hex (0001 0010 0100 0001): 
 

Addr Func Data count Data n Data n+1 Data n+2 Data n+x CRC LO CRC HI 

 0x41 0x12 

CRC programming example 
/* Table of CRC values for high-order byte */ 
static __flash unsigned char auchCRCHi[] = { 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 
0x41, 0x00, 0xC1, 0x81, 
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0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 
0x81, 0x40, 0x01, 0xC0, 
0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 
0xC1, 0x81, 0x40, 0x01, 
0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 
0x01, 0xC0, 0x80, 0x41, 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 
0x40, 0x00, 0xC1, 0x81, 
0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 
0x80, 0x41, 0x01, 0xC0, 
0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 
0xC0, 0x80, 0x41, 0x01, 
0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 
0x00, 0xC1, 0x81, 0x40, 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 
0x41, 0x00, 0xC1, 0x81, 
0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 
0x81, 0x40, 0x01, 0xC0, 
0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 
0xC1, 0x81, 0x40, 0x01, 
0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 
0x01, 0xC0, 0x80, 0x41, 
0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 
0x41, 0x00, 0xC1, 0x81, 
0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 0x41, 0x00, 0xC1, 
0x81, 0x40, 0x01, 0xC0, 
0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 0x01, 
0xC0, 0x80, 0x41, 0x01, 
0xC0, 0x80, 0x41, 0x00, 0xC1, 0x81, 0x40, 0x00, 0xC1, 0x81, 0x40, 
0x01, 0xC0, 0x80, 0x41, 
0x00, 0xC1, 0x81, 0x40, 0x01, 0xC0, 0x80, 0x41, 0x01, 0xC0, 0x80, 
0x41, 0x00, 0xC1, 0x81, 
0x40 
} ; 
 
/* Table of CRC values for low-order byte */ 
static __flash char auchCRCLo[] = { 
0x00, 0xC0, 0xC1, 0x01, 0xC3, 0x03, 0x02, 0xC2, 0xC6, 0x06, 0x07, 
0xC7, 0x05, 0xC5, 0xC4, 
0x04, 0xCC, 0x0C, 0x0D, 0xCD, 0x0F, 0xCF, 0xCE, 0x0E, 0x0A, 0xCA, 
0xCB, 0x0B, 0xC9, 0x09, 
0x08, 0xC8, 0xD8, 0x18, 0x19, 0xD9, 0x1B, 0xDB, 0xDA, 0x1A, 0x1E, 
0xDE, 0xDF, 0x1F, 0xDD, 
0x1D, 0x1C, 0xDC, 0x14, 0xD4, 0xD5, 0x15, 0xD7, 0x17, 0x16, 0xD6, 
0xD2, 0x12, 0x13, 0xD3, 
0x11, 0xD1, 0xD0, 0x10, 0xF0, 0x30, 0x31, 0xF1, 0x33, 0xF3, 0xF2, 
0x32, 0x36, 0xF6, 0xF7, 
0x37, 0xF5, 0x35, 0x34, 0xF4, 0x3C, 0xFC, 0xFD, 0x3D, 0xFF, 0x3F, 
0x3E, 0xFE, 0xFA, 0x3A, 
0x3B, 0xFB, 0x39, 0xF9, 0xF8, 0x38, 0x28, 0xE8, 0xE9, 0x29, 0xEB, 
0x2B, 0x2A, 0xEA, 0xEE, 
0x2E, 0x2F, 0xEF, 0x2D, 0xED, 0xEC, 0x2C, 0xE4, 0x24, 0x25, 0xE5, 
0x27, 0xE7, 0xE6, 0x26, 
0x22, 0xE2, 0xE3, 0x23, 0xE1, 0x21, 0x20, 0xE0, 0xA0, 0x60, 0x61, 
0xA1, 0x63, 0xA3, 0xA2, 
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0x62, 0x66, 0xA6, 0xA7, 0x67, 0xA5, 0x65, 0x64, 0xA4, 0x6C, 0xAC, 
0xAD, 0x6D, 0xAF, 0x6F, 
0x6E, 0xAE, 0xAA, 0x6A, 0x6B, 0xAB, 0x69, 0xA9, 0xA8, 0x68, 0x78, 
0xB8, 0xB9, 0x79, 0xBB, 
0x7B, 0x7A, 0xBA, 0xBE, 0x7E, 0x7F, 0xBF, 0x7D, 0xBD, 0xBC, 0x7C, 
0xB4, 0x74, 0x75, 0xB5, 
0x77, 0xB7, 0xB6, 0x76, 0x72, 0xB2, 0xB3, 0x73, 0xB1, 0x71, 0x70, 
0xB0, 0x50, 0x90, 0x91, 
0x51, 0x93, 0x53, 0x52, 0x92, 0x96, 0x56, 0x57, 0x97, 0x55, 0x95, 
0x94, 0x54, 0x9C, 0x5C, 
0x5D, 0x9D, 0x5F, 0x9F, 0x9E, 0x5E, 0x5A, 0x9A, 0x9B, 0x5B, 0x99, 
0x59, 0x58, 0x98, 0x88, 
0x48, 0x49, 0x89, 0x4B, 0x8B, 0x8A, 0x4A, 0x4E, 0x8E, 0x8F, 0x4F, 
0x8D, 0x4D, 0x4C, 0x8C, 
0x44, 0x84, 0x85, 0x45, 0x87, 0x47, 0x46, 0x86, 0x82, 0x42, 0x43, 
0x83, 0x41, 0x81, 0x80, 
0x40 
} ; 
 
unsigned short int CRC16(unsigned char *puchMsg, unsigned short int 
usDataLen) 
{ 
   unsigned char uchCRCHi = 0xFF; /* high byte of CRC initialized */ 
   unsigned char uchCRCLo = 0xFF; /* low byte of CRC initialized */ 
   unsigned uIndex ;              /* will index into CRC lookup 
table */ 
   while(usDataLen--)             /* pass through message buffer */ 
   { 
      uIndex = uchCRCHi ^ *puchMsg++ ; /* calculate the CRC */ 
      uchCRCHi = uchCRCLo ^ auchCRCHi[uIndex] ; 
      uchCRCLo = auchCRCLo[uIndex] ; 
   } 
   #ifdef INTEL_LIKE_PROCESSOR 
     return (unsigned short int)((uchCRCLo << 8) | uchCRCHi); 
   #else 
     return (unsigned short int)((uchCRCHi << 8) | uchCRCLo); 
   #endif 
} 

See also 

There are many ways of calculating a CRC checksum. For further information, please refer 
to the Modbus Organisation Website (http://www.modbus.org) , where detailed descriptions 
and programming examples are available.  

http://www.modbus.org/
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Exception codes E
E.1 Exception handling 

There is a defined set of exception codes to be returned by slaves in the event of problems. 
All exceptions are signalled in the response from the slave by adding 80 hex to the function 
code of the request and following this byte by an exception code.  

Table E- 1 Exception codes 

Exception 
code (dec) 

Exception text Description 

01 Illegal function The function code received in the query is not an allowable 
action for the slave 

02 Illegal data address The data address received in the query is not an allowable 
address for the slave. 

03 Illegal data value A value contained in the query data field is not an allowable 
value for the addressed location. This may indicate a fault in 
the structure of the remainder of a complex request, such that 
the implied length is incorrect or the number of registers is too 
high. 

04 Slave device failure The request is for some other reason not acceptable. It may 
e.g. indicate that the data value to write is evaluated to be
beyond limits.
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Float definition F 
F.1 Float definition 

Stuffing of multi-byte numbers into multiple Modbus RTU registers differs among Modbus 
devices. "Big Endian" and "Little Endian" describe the order or sequence in which multi-byte 
data is stored in memory. This device uses (IEEE 741) a "Big-Endian" representation for 
addresses and data items as default. This means that when a numerical quantity larger than 
a single byte is transmitted, the MOST significant byte is sent first. 

Float transmission order can be changed as described in Float transmission (Page 77). 
 
Following example describes the Big-Endian representing of float IEEE741. 

 

Value (decimal) IEEE FP B MSB 
LSB 

Register N Register N + 1 

high low high low 

100.0 42C80000h 42h C8h 00h 00h 

55.32 425D47AEh 42h 5Dh 47h AEh 

2.0 40000000h 40h 00h 00h 00h 

1.0 3F800000h 3Fh 80h 00h 00h 

-1.0 BF800000h bFh 80h 00h 00h 

Read absolute massflow (4.03001) 
 

Query: 01,03,0B,B8,00,02,46,0A 

Response: 01,03,04,40,C3,52,93,62,C8 

Absolute massflow = 6.10383 kg/s 

 



Float definition  

F.1 Float definition 
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Glossary  
 

Coriolis 

The Coriolis effect is an apparent deflection of moving objects from a straight path when they 
are viewed from a rotating frame of reference. The effect is named after Gaspard-Gustave 
Coriolis, a French scientist who described it in 1835. The Coriolis effect is caused by the 
Coriolis force, which appears in the equation of motion of an object in a rotating frame of 
reference.  

CRC Cyclic Redundancy Check 

Cyclic Redundancy Check is used for error checking in Modbus RTU.  

EHDG 

European Hygienic Engineering & Design Group was founded in 1989 to promote hygienic 
engineering in the European food industry. EHEDG provides practical guidance on hygienic 
engineering aspects of manufacturing safe and whole some foods.  

EMC 

Electromagnetic compatibility (EMC) is the branch of electrical sciences which studies the 
unintentional generation, propagation and reception of electromagnetic energy with 
reference to the unwanted effects (Electromagnetic Interference, or EMI) that such energy 
may induce. The goal of EMC is the correct operation, in the same electromagnetic 
environment, of different equipment which use electromagnetic phenomena, and the 
avoidance of any interference effects. 

IP 

An IP (Ingress Protection) number is used to specify the environmental protection of 
enclosures around electronic equipment. These ratings are determined by specific tests. The 
IP number is composed of two numbers, the first referring to the protection against solid 
objects and the second against liquids. The higher the number, the better the protection. For 
example, in IP67 the first Number (6) means that the device is totally protected against dust, 
and the second (7) that it is protected against the effect of immersion between 15cm and 1m 

Modbus 

Modbus is a serial communications protocol intended for use with programmable logic 
controllers (PLCs). Modbus allows for communication between many devices connected to 
the same network, for example a system that measures temperature and humidity and 
communicates the results to a computer. Modbus is often used to connect a supervisory 
computer with a remote terminal unit (RTU) in supervisory control and data acquisition 
systems. 
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Modbus address 

Throughout this document the following notation is used to address Modbus RTU registers: 

4: 1234: Holding register 1234 (addressed in messages by 1233) 

4: 54321: Holding register 54321 (addressed in messages by 54320) 

34567: The address of a holding register as specified in a message  

Modbus master 

A Modbus master is a Modbus device which is able to access data in one or more connected 
Modbus slaves. 

Modbus slave 

A Modbus slave is a Modbus device which is able to respond to requests from a single 
Modbus master. 

NAMUR 

Normenarbeitsgemeinschaft für Meß- und Regeltechnik in der Chemischen Industrie 
(NAMUR). NAMUR is a group representing the interests of the chemical industry which 
create standards for instrumentation and electrical devices used in industrial plants. 

PED 

The Pressure Equipment Directive (97/23/EC) is the legislative framework on European level 
for equipment subject to a pressure hazard. It was adopted by the European Parliament and 
the European Council in May 1997 and has been obligatory throughout the European Union 
since May 2002.  

Zero point adjustment 

In order to measure accurately with a measuring instrument it is important that zero and gain 
have been calibrated. All Coriolis sensors are calibrated before they are sent out to 
customers. However, Coriolis sensors are very sensitive, and several factors might move the 
zero point, for example installation, pressure, temperature and even very small vibrations 
coming from the process. All these factors are customer specific and can’t be simulated at 
the factory. Therefore Siemens recommends to carry out a zero point adjustment before use. 
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Index  
A 

Accuracy 

Density, 93 

Massflow, 93 

Temperature, 93 

Approval nameplate 

Sensor, 12 

C 

Cable specifications, 37, 101 

CE mark, 15 

Certificates, 15 

Certificates and approvals, 102 

Characteristics 

Density calibration, 134 

Massflow calibration, 134 

Sensor, 133 

Volumeflow calibration, 133 

Commissioning 

Steps, 52 

Communication 

Modbus, 132 

Communication parameters 

Setup, 54 

Compliance 

European directives, 15 

Contact person, 14 

Coriolis 

Applications, 21 

Measurement principle, 25 

Correct usage, (See improper device modifications) 

Cross talk, 33, 88 

Customer Support Hotline, 82 

D 

Design, 22 

Design, sensor, 99 

Designated use, 91 

Device 

Identification, 9, 11, 12 

Diagnose 

with SIMATIC PDM, 85 

Dimensions and weight, 111 

Document history, 7 

E 

Electrical connection 

Cable specifications, 37 

In hazardous area, 37 

Empty tube monitoring, 72 

Exception codes, 149 

F 

Flow direction, 29 

H 

Handling, 32 

Hazardous area 

Electrical connection, 37 

Laws and directives, 15 

Hazardous locations 

Approvals, 17 

Hot swappable, 110 

Hotline, 82 

I 

Identification 

Sensor, 123 
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Identification nameplate 

Sensor, 9 

Improper device modifications, 16 

Installation 

Drop line, 31 

Gas, 29 

Incorrect, 88 

Indoor/outdoor, 27 

Inlet / Outlet conditions, 29 

Liquid, 29 

Location in the system, 28 

Mounting of sensor, 32 

Orienting the sensor, 30 

Pressure guard, 34 

Safety instructions, 27 

Upstream / Downstream, 29 

Installation torques, 102 

Internet 

Contact person, 14, 83 

Flow documentation, 14 

Modbus Organization, 24 

Support, 82 

L 

Low flow cut-off, 71, 88 

Low Mass Flow Cut-Off, 72 

Low Volume Flow Cut-Off, 72 

M 

Maintenance, 81 

Maintenance and Diagnostics 

Access level, 128, 138 

Aerated flow, 129 

Device diagnostics, 129 

Maintenance, 128 

Zero point adjustment, 130 

Modbus 

Features, 23 

Frame, 24 

Network, 54 

Organization Website, 24 

Technical data, 92 

Technology, 24 

Modbus holding registers 

Alarms, 136 

Characteristics, 133 

Communication, 132 

Identification, 123 

Maintenance & Diagnostics, 128, 138 

Process values, 123 

Setup, 124 

Simulation, 135 

Totalizer, 126 

Mounting, (See Installation) 

P 

PDM 

Commissioning steps, 52 

Zero point adjustment, 65 

Performance, 93 

Power supply, 100, 100 

Pressure 

Safety instructions, 27 

Process noise damping, 73 

Process values, 69, 123 

Process variables, 91 

R 

Rated operating conditions, 94 

Recalibration, 82 

Reference conditions, 93 

Repair, 81 
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S 

Safety 

Sensor installation, 27 

Scope of delivery, 9 

Sensor orientation, (See Installation) 

Service, 81, 82 

Service information, 81 

Setup 

Density, 125 

Massflow, 125 

Operating conditions, 124 

Volume flow, 125 

Signal processing, 26 

Simulation, 76, 135 

Specification nameplate 

Sensor, 11 

Support, 82 

Symbols, (Refer to warning symbols) 

System design, 91 

System integration, 23, 43 

T 

Technical data, 91 

Temperature specifications, 18 

Termination DIP switches, 42 

Test certificates, 15 

Totalizer, 126 

U 

Unicast communication mode, 24 

V 

Vibrations, 33, 88 

W 

Warning symbols, 17 
 

Z 

Zero point adjustment, 65, 70, 141 

Automatic, 70, 141 

via PDM, 65 
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